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Preface

Purpose of the Manual

This manual is a set of instructions for the software SIGUARD PDP. You obtain an overview of the possibilities 
for use and configuration.

Target Audience

This manual is addressed mainly to the operating crew, commissioning engineers, and quality managers who 
are responsible for the configuration, parameterization, and monitoring of power systems and their compo-
nents.

Scope of Application of this Manual

This manual applies to SIGUARD PDP V2.10.

Standards

SIGUARD PDP was developed in compliance with guidelines in DIN EN ISO 9001:2008.

Additional Support

For questions about the system, please contact your Siemens sales partner.

Support

Our Customer Support Center provides a 24-hour service.

Tel.: +49 (1805) 24-7000

Fax: +49 (1805) 24-2471

E-mail: support.ic@siemens.com

Training Courses

Inquiries regarding individual training courses should be addressed to our Training Center:

Siemens AG

Siemens Power Academy

Humboldtstraße 59 

90459 Nuremberg 

Tel.: +49 (911) 433-7415 

Fax: +49 (911) 433-5482 

E-mail: td.power-academy.energy@siemens.com

Internet: http://www.siemens.com/energy/power-academy
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Preface
 

Safety Information

This manual is not a complete index of all safety measures required for operation of the equipment (module, 
device). However, it comprises important information that must be noted for purposes of personal safety, as 
well as in order to avoid material damage. Information is highlighted and illustrated as follows according to the 
degree of danger.

DANGER
DANGER means that death or severe injury will result if the measures specified are not taken.

✧ Comply with all instructions, in order to avoid death or severe injuries.

WARNING
WARNING means that death or severe injury may result if the measures specified are not taken.

✧ Comply with all instructions, in order to avoid death or severe injuries.

CAUTION
CAUTION means that medium-severe or slight injuries can occur if the specified measures are not taken.

✧ Comply with all instructions, in order to avoid medium-severe or slight injuries.

NOTICE
NOTICE means that material damage can result if the measures specified are not taken.

✧ Comply with all instructions, in order to avoid material damage.

 NOTE

Important information about the product, product handling, or a certain section of the documentation, which 
must be given particular attention.
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SIGUARD PDP System Overview
1.1 Overview
1.1 Overview
.

SIGUARD PDP (Phasor Data Processing) is software for monitoring the status of power transmission in ex-
tensive power-supply systems. When critical states are approached (frequency stability, voltage stability, trans-
mission stability, and power swing), this is detected early and displayed. The threshold as of which a critical 
state is reached and requires intervention can be defined and subsequently changed at any time.

In addition, SIGUARD PDP supports you in the analysis of the power-supply system. 

SIGUARD PDP works together with PMUs (phasor measurement units). These measuring devices are installed 
in the power distribution systems and connected to the current and voltage transformers. The time of the PMUs 
must be synchronized via GPS with an accuracy of < 5 μs. This enables the PMUs to acquire the measured 
values with amplitude and phase as phasors (indicator values) with high precision and to transmit them via the 
communication interface. These time-synchronized measured values from regionally widely distributed mea-
suring points can be collected and evaluated using SIGUARD PDP.

Software Components 

SIGUARD PDP consists of 5 software components. They can run on one computer, but also be distributed over 
3 computers. If the components are distributed over several computers, they communicate using SSI (SI-
GUARD Service Interface). SSI requires a functional TCP connection.

The SIGUARD PDP components are:

• SIGUARD PDP Server with SIGUARD PDP Archive
The SIGUARD PDP Server stores the information of the PMU devices and makes it available to the other 
components. The SIGUARD PDP Server stores the information (measured values, events, and warning 
indications) in a ring archive and makes it available to further processing components, for example, 
SIGUARD PDP UI. The IEEE C37.118 protocol is used for communication with the devices.

• SIGUARD PDP ISD (Island Detection)
This component evaluates frequency deviations and thereby detects the formation of an island within the 
network.

• SIGUARD PDP PSR (Power Swing Recognition)
This component detects active power swings in the power system. The parameters of the active power 
and the voltage angle difference that is proportional to the active power (frequency, magnitude, damping, 
and criticality), for several swings (modes) are observed and evaluated. In the overview diagram, a swing 
is marked with colored points, and on the map they are displayed with circular areas.

• SIGUARD PDP COM (Communication)
- C37.118

This component conveys the data and information via an IEEE C37.118 connection to another PDP 
system (for example, a second SIGUARD PDP).

- ICCP

With the Inter-Control Center Communications Protocol, information from SIGUARD PDP can be 
relayed to a SCADA-System in order to be able to display the data to the network control personnel 
there and to be able to process the data further in the more significant functions of the control system 
(EMS).

- OPC

An OPC DA-Server (V3) is made available with this component. Selected information from SIGUARD 
PDP can be read out and processed further by OPC Clients.

• SIGUARD PDP UI (User Interface)
This component is the SIGUARD PDP user interface. You can use it to display and analyze the informa-
tion.

• SIGUARD PDP Engineer
This component is the SIGUARD PDP parameterizing tool.
SIGUARD PDP Phasor Data Processing, Manual
E50417-H1076-C419-A3, Release 11.2011
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SIGUARD PDP System Overview
1.1 Overview
Recommendation: Install SIGUARD PDP server on a server computer, for example, in a server room with 
secure power supply, and also set up the archive on it. Install SIGUARD PDP UI on a different computer. 

Figure 1-1 Software Components of SIGUARD PDP

SIGUARD PDP UI (User Interface)

The SIGUARD PDP user interface consists of several window sections: 

• Menu and Toolbar
You can call up general functions via the menu and the toolbar.

• PSS Curve (Power System Status)
This window section displays the combined status of the entire measured or monitored power-supply 
system. An exceeded critical threshold is marked in color.

• SIGUARD PDP UI - Map
This window section shows the network topology of the power-supply system on a map. Objects in a crit-
ical state are marked in color:

- Island recognition as areas between the stations

- Power swing recognition as circular areas around the stations

• Chart View
This window section displays the detailed curves of individual measured values or calculated values over 
a defined time range. With the aid of these diagrams, you can analyze the power-supply system.

• Measurements, applications and formulas
This window section lists the measuring points, applications, formulas, and statistics. You can create dia-
grams from these lists.
SIGUARD PDP Phasor Data Processing, Manual
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SIGUARD PDP System Overview
1.1 Overview
• Event list, Alarm list
In this window section, events and alarm indications are listed.

• Power Swing Analysis
In this window section, the PSR jobs for the stations in the power system are listed with the corresponding 
phase angle and PSR modes.

Figure 1-2 SIGUARD PDP UI, Main Window

• Limit Editor
In the Limit Editor, you define the limiting values/thresholds for the individual measuring point of the 
power-supply system that are to play a role in the evaluation.
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1.1 Overview
Figure 1-3 SIGUARD PDP, Limit Editor

SIGUARD PDP Engineer

With SIGUARD PDP Engineer, you configure the complete SIGUARD PDP system. Here you can configure 
PMUs, calculated values, the graphical display, applications, and the data distribution in separate, respective 
windows. 

Figure 1-4 SIGUARD PDP, SIGUARD PDP Engineer
SIGUARD PDP Phasor Data Processing, Manual
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1.2 Performance Features
1.2 Performance Features  
.

SIGUARD PDP is self-standing software and runs independent of other applications.

Data Volume

SIGUARD PDP processes the data from up to 4,000 measuring channels (for example, phasors, analog/digital 
measured values) and 1,000 calculated values. 

The measured values can originate in PMU devices or PMUs from third parties. The devices must be able to 
use the communication protocol IEEE C37.118. A maximum of 100 PMUs can be connected to the SIGUARD 
PDP Computer.

Free hard disk drive capacity for the ring archive of approx. 14 GB is required for the following configuration: 

• 64 channels (for example, 8 PMUs with 8 channels each)

• A repetition rate of 10 values per second (reporting rate)

• A storage duration of 7 days

For storage of events, alarms, and time ranges, additional hard disk drive capacity is required.

The performance of SIGUARD PDP can be improved by setting up the archive on a hard disk drive separate 
from the one on which the SIGUARD PDP Server is set up. The performance can be further improved by setting 
up the ring archive and the permanent archive on different hard disks.

The archive is designed as a ring archive and can store data for a duration of 7 days, for instance. After 7 days 
have passed, the oldest data are overwritten. Archived data can be saved permanently in the permanent 
archive or exported to a CSV file and then processed further.

SIGUARD PDP UI

Up to 8 SIGUARD PDP UIs can be operated by a SIGUARD PDP Server. The associated licenses are required.

Time Synchronization

For the assignment of measured values detected simultaneously from locations that lie far apart, the measured 
values must have a precise timestamp. For this reason, all connected devices must have an accurate time 
base. No high-precision time base is required for the actual SIGUARD PDP software. However, you can syn-
chronize the SIGUARD PDP Computer, for example, with the GPS/DCF 77 time signal receiver by Hopf or NTP 
(Network Time Protocol). This would also ensure highly precise timestamps assigned by the SIGUARD PDP 
Computer via NTP, for example, for communication monitoring. Furthermore, measuring devices erroneously 
synchronized with the wrong time, for example, measuring devices using local time instead of (Universal Time 
Coordinated), can be recognized.

Interfaces

The PMUs are connected via Ethernet (optionally TCP or UDP (User Datagram Protocol)) and the communi-
cation protocol IEEE C37.118 with the SIGUARD PDP computer.

Function Monitoring

SIGUARD PDP monitors: 

• the communication between the SIGUARD PDP software components

• the communication with the devices

• the function of important software components

Events and alarms are saved and can be displayed in lists (see 2.7.1 Overview).
SIGUARD PDP Phasor Data Processing, Manual
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1.3 Configuration Example 
.

The configuration example shown below contains the following components:

• PMU
The PMU devices are installed at strategically important points in the power-supply system and supply the 
measured values.

• SIGUARD PDP Server
SIGUARD PDP server collects data from the PMU devices, stores them in an archive, and makes them 
available to SIGUARD PDP UI, for example. 

• SIGUARD PDP UI (User Interface)

With SIGUARD PDP UI, you can display archived data and analyze it. On a SIGUARD PDP server, you 
can simultaneously access several SIGUARD PDP UIs. 

In the example, the PMU devices are in 2 local networks (LAN - Local Area Network). These are connected 
with a local network on the office level via a WAN (Wide Area Network).

Figure 1-5 System Configuration with SIGUARD PDP, Example
SIGUARD PDP Phasor Data Processing, Manual
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1.4 Calculate Power System Status

1.4.1 Overview
.

All measured values of a system are evaluated by SIGUARD PDP UI with the aid of an algorithm and analyzed 
in such a way as to allow the point in time of a failure to be detected. The measured values are shown graph-
ically with the PSS curve. The time range for the analysis can be selected as desired.

Figure 1-6 PSS Curve with Critical Measured Values (Red Curve)

The algorithm combines the measured values of the determined criteria and calculates the display height with 
it.

For this, the algorithm evaluates the following questions:

• How large is the difference between individual measured values and the set limiting value?

• How many measured values have approached the limiting value up to a defined limit?

• How is the significance of the measured values defined in comparison to other measured values (PSS 
factor)?

• How many measured values deviate from the set limiting value?

If the set limiting value of the curve is exceeded, it is displayed as critical (red curve, highlighted in red).

Further information on calculating the PSS curve can be found in chapter 1.4.3 Calculations.

1.4.2 Configuration of the measured value evaluation
.

The parameters of the measuring points are required to calculate the PSS curve. These can be configured with 
SIGUARD PDP Engineer:

• Amount of a phasor or an analog value

• Rated value

• 1 to 3 upper limiting values (H1 to H3)

• 1 to 3 lower limiting values (L1 to L3)

• Weighting (PSS factor)

 NOTE

In order to be able to perform the calculation of the PSS curve, at least the rated value and a limiting value must 
be specified. Here the following must apply: H1 < H2 < H3 and L3 < L2 < L1.

 

The specification of the limiting values relates to the rated value. The current measured values are compared 
with the limiting values.
SIGUARD PDP Phasor Data Processing, Manual
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The various limiting values have different significance regarding the rated value:

Figure 1-7 Limiting Values and Critical Ranges
(1) Limiting value H3
(2) Limiting value H2
(3) Limiting value H1
(4) Rated value
(5) Limiting value L1
(6) Limiting value L2
(7) Limiting value L3

• Measured values between H1 and L1 lie in the normal operating range

• Measured values between H1 and H2 or L1 and L2 lie in the questionable operating range

• Measured values between H2 and H3 or L2 and L3 lie in the critical operating range

 NOTE

Only 1 alarm is always pending. If the value exceeds the limit from H1 to H2, there are 2 events: H1 outgoing 
and H2 incoming.

 

1.4.3 Calculations
.

The calculation of the PSS curve is performed according to a defined algorithm in 5 steps.

Step 1: Scaling of the Measured Values to Their Limiting Value

A measured value is scaled to its upper and lower limiting values (bands). This scaled value is shown as a per-
centage. The percentage states how highly loaded the corresponding band is.

• For measured values larger than the rated value, the following applies: 

0 % = current measured value lies below the band. 

100 % = current measured value is larger than or equal to the upper limit of the band

Scaled value X = (current value – lower limit of band)/(band upper limit – band lower limit)
SIGUARD PDP Phasor Data Processing, Manual
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1.4 Calculate Power System Status
• For measured values smaller than the rated value, the following applies:

 0 % = current measured value lies above the band. 

100 % = current measured value is smaller than or equal to the lower limit of the band

Scaled value X = (current value – upper limit of band)/(band upper limit – band lower limit) 

Example: 

The PSS value should be composed of the 3 measured values M1, M2, and M3. Here the current values are 
M1 = 157, M2 = 120, and M3 = 135. 

Table 1-1 Scaling of the Measured Values to Their Limiting Value

In this example, only the rated value and 3 upper limiting values H1 to H3 are defined. With the measured 
values M1 to M3, the scaled value XM1 to XM3 are shown as a percentage.

• The first measured value M1 (157) lies between the upper limiting values H2 (150) and H3 (160). Since 
the scaled value XM1 is larger than the rated value, it is calculated from:

X = (current value – band lower limit H2)/(band upper limit H3 – band lower limit H2) = (157 – 150) / (160 
– 150) = 7 / 10 = 0.7000 

The band between H2 and H3 is loaded with 70.00 %.

• The second measured value M2 (120) lies between the rated value and the upper limiting value H1 (130). 
Since the scaled value XM2 is larger than the rated value, it is calculated from:

X = (current value – band lower limit N)/(band upper limit H1 – band lower limit N) = (120 – 100) / (130 – 
100) = 20 / 30 = 0.6667 

The band between the rated value and H1 is loaded with 66.67 %.

• The third measured value M3 (135) lies between the upper limiting values H1 (130) and H2 (150). Since 
the scaled value XM3 is larger than the rated value, it is calculated from:

X = (current value – band lower limit H1)/(band upper limit H2 – band lower limit H1) = (135 – 130) / (150 
– 130) = 5 / 20 = 0.25 

The band between H1 and H2 is loaded with 25.00 %.

These percentages enter into the further calculation of the PSS curve.

Step 2: Global Average Per Band (GDB)

GDB = Sum of all (valueB * weighting) / (sum of the weightings)

GDB = (XM1 + XM2 + XM3) / 3

In the example, the weightings of the measured values are (PSS factor) = 1.

In table 1-1, the 3 values GDB are calculated for the 3 bands, for example, in band H3: GDB = (70 % + 0 % + 0 
%) / 3 = 23.33 %.

Step 3: Definition of the Local Maximum (LM)

The largest value in the highest band defines the local maximum.

Example: XM1

 M1  XM1 M2  XM2 M3  XM3 GDB

H3 160 H3 - H2 70.00 % 160 < H2 0 % 160 < H2 0 % 23.33 %
H2 150 > H2 100 % 150 < H1 0 % 150 H2 - H1 25.00 % 41.67 %
H1 130 > H1 100 % 130 H1 - N 66.67 % 130 > H1 100 % 88.89 %
Rated value 100   100   100    
Current measured 
value

157   120   135    
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Table 1-2 Definition of the Local Maximum

 NOTE

If all values are 0% in the highest band H3, the highest value (deviation from 0%) in the second-highest band 
H2 defines the local maximum.

 

Step 4: Calculation of the Average Between GDB and LM

A single failure should also be evident in the global maximum.

TB = (LMB + GDB) / 2

Table 1-3 Definition of the Local Maximum

Step 5: Calculation of the Global Indicator

The global indicator is the average value of the sum of TB of all bands and is calculated as follows:

(TB(H1) + TB(H2) + TB(H3)) / 3 = 70.65 %

If the limiting value of 60 % is exceeded, as in the example, the PSS curve is displayed in red and is highlighted 
with a red area. The red coloring represents the critical range.

 NOTE

The algorithm for calculating the PSS curve has a patent pending.

 

 XM1 XM2 XM3

H3 70.00 % 0 % 0 %
H2 100 % 0 % 25 %
H1 100 % 66.67 % 100 %

 XM1 GDB TB

H3 70.00 % 23.33 % 46.67 %
H2 100 % 41.67 % 70.84 %
H1 100 % 88.89 % 94.45 %
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1.5 SIGUARD PDP Power Swing Recognition (PSR)
.

The SIGUARD PDP Power swing recognition (PSR) can recognize, evaluate, and display active power swings 
in the power system. In this way, critical power swings in the energy supply network are recognized and report-
ed automatically.

The SIGUARD PDP Power swing recognition can execute several PSR jobs simultaneously. There are 2 dif-
ferent kinds of jobs, which differ regarding input variables:

• Angle difference between 2 voltage phasors which are measured at 2 different points in the power system 
(also see UI: Phase Angle Difference). 

This variant requires 2 Phasor-Measurement Units (PMUs) that each supply at least voltage phasors.

• Active power that is measured as the product of the voltage phasor and current phasor at one point in the 
power system (see also UI: Active Power).
This requires a PMU which supplies the voltage and current phasors.

Different Jobs for swing recognition are defined, depending on the selected input variables and the corre-
sponding PMU combination. The PSR executes these jobs simultaneously.

The input signals in the form of angle difference or active power, are written back to the PDP Server continually 
for comparison with the later events of the swing recognition in order to display them for subsequent analysis 
of swing processes in SIGUARD PDP UI. Within the PSR, these values are accumulated over preselected time 
ranges. If the data are complete, these values are transformed into the frequency range in order to recognize 
the characteristic frequencies for the observed swing process. Since several frequencies can be picked up si-
multaneously, the PSR can identify and calculate several modes simultaneously. The maximum number of the 
expected modes and their typical frequency ranges are defined in SIGUARD Engineer.

For every pickup frequency, the current value of the magnitude is calculated. It may be necessary to measure 
over a longer period of time, depending on swing frequency. For this reason, errors can occur during the in-
creasing or decreasing process that is typical for power swings.

A quantity that is essential regarding the possible effects is the damping factor ξ (zeta) with respect to the swing 
frequency. In the following, it is referred to as damping for simplicity. The variable is dimensionless and stated 
in the following as percentages. It gives a relative measure – independent of the frequency of the power swing 
– for the change in magnitude of the swing from any given maximum to the next.

Negative damping ξ is characteristic of a power swing that is decreasing in magnitude. The following figure 
shows a corresponding change in magnitude with time for the sake of illustration.

Figure 1-8 Pickup of a subsequently decreasing power swing for a job of the type Active Power
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1.5 SIGUARD PDP Power Swing Recognition (PSR)
The damping ξ of the power swing shown is -10 %. The frequency is 1.2 Hz.

A power swing with a damping ξ below -5 % is considered uncritical if the magnitude is not too high.

 NOTE

Take special note of swing events above a damping of -3 %, since further pickups in the power system can lead 
to a quick rise in the magnitude.

 

Unattenuated power swings are particularly critical. A damping of 0 % corresponds to a magnitude that is not 
changing with time. Increasingly positive values are accompanied by an increasing magnitude trend that gets 
steeper over time. The following figure shows, as an example, a power swing with this behavior.

Figure 1-9 Increasing power swing for a job of the type Phase Angle Difference

The damping ξ of the power swing shown is +10 %. The frequency is 0.2 Hz.

In order to judge the consequences of a swing event, a quantity that characterizes the potential hazard is de-
termined from the damping ξ (damping ratio) in conjunction with the current swing magnitude Â. This quantity 
is designated in the following as DOE (Degree of Exposure). The increase in the damping factor and swing 
magnitude is accompanied by a hazard. This hazard is indicated by an increasing value of the DOE. The fol-
lowing figure illustrates determination of the DOE value.
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Figure 1-10 Calculating the DOE

The calculation of the DOE is based on limits of damping (damping ratio limits) and magnitude (magnitude lim-
its). These limits are determined in SIGUARD Engineer (see chapter 4.7.3 Power Swing Recognition PSRs) 
for each job.

■
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2.1 Overview
2.1 Overview
.

The program interface of SIGUARD PDP consists of the following interface components:

• Menu and Toolbar
You can call up general functions via the menu and the toolbar (see 2.2 Menu and Toolbar).

• PSS Curve
This window section displays the combined status of the entire measured or observed power-supply 
system as Power System Status.

• SIGUARD PDP UI - Map
This window section shows the network topology of the power-supply system on a map.

• Chart View
This window section displays the detailed curves of individual measured values or calculated values over 
a defined time range.

• Measurements, applications and formulas
This window section  contains lists than can be shown and hidden:

- Measuring points used

- All available measuring points

- Predefined formulas

- Voltage stability curves

- Statistics

You can find further information on this in chapter Measured values, applications and formulas.

• Event list, Alarm list
In this window section, events and alarm indications are listed.

• PSR Analysis
In this window section, the PSR jobs for the stations in the power system are listed with the corresponding 
phase angles and PSR modes.

You can change the size and arrangement of the window sections to meet your requirements, see 
2.8 Arranging Program Interface. 
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2.1 Overview
Figure 2-1 Schematic Representation of the User Interface
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2.2 Menu and Toolbar

Menu Entries

You can call up the following functions via the menu:

• File > Save to CSV ...
With this menu item, you can save the measured values of the current time range as a CSV file, see 
2.10 Reporting.

• File > Save time range...
With this menu item, you can save the measured values of the current time range in the permanent ar-
chive, see 3.4.1 Exporting of Time Ranges. 

• File > Load time range...
With this menu item, you can load the measured values of a previously saved time range from the perma-
nent archive, see 3.4.2 Importing Time Ranges. 

• File > Delete time range...
With this menu item, you can delete the measured values of a previously saved time range from the per-
manent archive, see 3.4.3 Deleting Time Ranges.

• File > Exit
With this menu item, you close SIGUARD PDP UI.

• Help > Contents...
With the menu item, you call up the online manual.

• Help > Index
With the menu item, you call up Online Help. The functionality of SIGUARD PDP discussed. It also con-
tains instructions for working with the various components of SIGUARD PDP.

• Help > About SIGUARD PDP UI...
With this menu item, you query the current SIGUARD PDP UI program version. 

Toolbar

Via the toolbar in the main window, you can call up the following functions: 

Table 2-1 Main Window Toolbar

Icon Explanation

Click this icon in order to open a new chart view.

Click this icon in order to display the map SIGUARD PDP UI - Map.

Click this icon in order to open a new event list.

Click this icon in order to open a new alarm list.

Click this icon to open the window section Power Swing Analysis. 

Click this icon in order to save the current UI as a favorite.
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2.2 Menu and Toolbar
Status of Limiting Values 

Beneath the menu bar, there is a bar with the designation PSS Curve. The color of this bar shows the status 
of the limiting values.

• Gray
All entered limiting values are in effect and are accounted for in the display.

• Orange
At least one limiting value was changed. The change affects the local computer, but not the entire system. 
You can find information on how to enter limiting values in the section 2.9 Limit Editor.

• Pink
SIGUARD PDP UI has lost the connection to the SIGUARD PDP Server. Wait until the connection is re-
established or contact the administrator of the server.

The selected favorite will be displayed in the text box. The list box dis-
plays all saved favorites. 

Click this icon in order to delete a favorite.

Icon Explanation
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2.3 Power System Status
.

In the Power System Status window section, you see a curve displaying the state of the complete power 
system. The curve can be calculated from all available measured values for which the limiting values are de-
fined, see 1.4.1 Overview. With the tool SIGUARD PDP Engineer, you can assign parameters for which mea-
sured values are to be included in the calculation, see 4.4 Phasor Measurement Unit (PMU). The curve is cal-
culated from the weighted distances between the measured values and their limiting values.

You can define the displayed time range of the curve. It is divided into defined time steps, for example, hours. 
The right end of the diagram shows the current value.

Displaying Current Values 

Display the current values as described in the following:

✧ Click the Go online button to the right of the selection list.

The curve is continuously updated with current values.

Figure 2-2 Power System Status, current values (online mode)

The set time range, for example, day, is represented as a curve and updated continuously. Values that have 
already been displayed are moved to the left. The latest value is shown on the right side.

If not enough values are available yet, for example, in the start phase, the left side of the curve is empty. It is 
completed by newly arriving values.

Displaying Values from the Past 

For subsequent analysis, you can display values from the past (archive values) as curves in the PSS Curve 
and Chart View sections of the window.

Set the values from the past as follows:

✧ Click the Go offline button to the right of the selection list. 

The curve is no longer updated with current values. 

Switching to Offline mode only affects SIGUARD PDP UI. SIGUARD PDP continues to archive the incoming 
values, but they are not displayed in this SIGUARD PDP UI. You can launch a second instance of SIGUARD 
PDP UI on the same computer and thereby stay online.
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Figure 2-3 Power System Status, Offline Values

The selected time interval is set by 2 sliders. A cursor is displayed within the time interval. You can move the 
sliders and the cursor on the time line with the mouse.

An enlarged display of selected values, for example, voltage and power of this time interval is possible in the 
Chart View window section.

The position of the cursor in the time interval has the following effects:

• Its time position is automatically transferred to the cursors in the line charts. 

• Both phasors in vector diagrams and stability curves are displayed for the instant determined with the 
cursor.

• The state of the objects is shown in the window section SIGUARD PDP UI - Map depending on the cursor 
position. 

• In the Event list, a black horizontal line is shown, which separates the range of the events already entered 
from those that will arrive in the future, as seen from the cursor.

• The Alarm list displays the events that have been queued at this time point.

Setting Options/Displays 

✧ Change the display of the curve in the window section PSS Curve using buttons and list boxes. 

 

The following table explains the setting options and displays for the PSS Curve window section.

Table 2-2 Window Section PSS Curve

Element Explanation
You can select the date from a calendar. 

You can select the time range to be represented as a curve from a list:
• Month
• Week
• Day
• Quarter day (6 hours)
• Hour
• 10 Minutes
• Minute
• 10 Seconds

You can also change the time range shown by clicking the time bar, see 
below.
1) When offline display is activated, the top arrows enable you to scroll 
forward or backward through the value archive page by page.  
2) With the aid of the bottom arrows, you can move forward or backward 
through the archive in small steps.
Use this button to set online mode. The current values are displayed as 
a curve.
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You can zoom in on the time range shown by clicking the upper line of the time bar, for example, from 1 min 
to 10 min. 

You can zoom out of the time range shown by clicking the lower line of the time bar, for example, from 1 hour 
to 10 min.

Figure 2-4 Power System Status, Change Time Range

Simulation of the PSS Curve

If you would like to test what effect the changed limiting values of the measured values have on the PSS curve, 
you can perform a simulation of the PSS curve. In this way, you can optimize the settings of the limiting values, 
such that the PSS curve shows the appropriate sensitivity for your power system. The simulation shows the 
effect a change in the limiting values has on the PSS curve. The simulated PSS curve is placed as a red line 
on the current PSS curve (black line).

Requirements for the simulation of the PSS curve (button Start simulation is active):

• A connection to the SIGUARD PDP server is established (status row: online).

• The offline mode is set.

• Limiting values were changed locally.

Use this button to set offline mode. Values from the archive are dis-
played as a curve. Using the arrows, you can scroll through the archive.
Non-critical values of the power-supply system are displayed as a black 
curve in the lower section of the display.
Critical values of the power-supply system are displayed as a red curve 
in the top part of the display. The higher the value is represented on the 
y-axis, the more critical it is. 
The critical time range is highlighted in light red. 
Use this button to move the cursor to the start of the selected time 
range. This function is available only in offline mode.

Use this button to start the sequence. The cursors in the charts move 
along automatically. In addition, the status of the objects at the respec-
tive instant is displayed on the map. This function is available only in 
offline mode.
Use this button to stop the sequence. This function is available only in 
offline mode with launched sequence.

Use this button to start simulating the PSS curve. This function is avail-
able only if:
• a connection to the SIGUARD PDP server is established
• the offline mode is set
• limiting values were changed locally

Element Explanation
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2.3 Power System Status
You simulate a PSS curve in this way:

✧ Select any measured value, for example, a frequency, from the list All measurements, and display these 
as a diagram.

✧ Display the limiting values for the displayed diagram.

✧ Change one or several limiting values.

 NOTE

Do not save the changes with Save limits, since otherwise the previous PSS curve would be changed in the 
system.

 

✧ For the simulation of the PSS curve, close the dialog for changing the limiting values with Close.

The color of the PSS bar bar changes from gray to orange.

✧ Start the simulation by clicking the button Start Simulation.

The simulated PSS curve is calculated. The original PSS curve is a black line; the simulated PSS curve with 
the changed limiting values is displayed as a red curve.

Figure 2-5 PSS Curve (Original and Simulated Curve)
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2.4 Map
2.4 Map
.

In the window section SIGUARD PDP UI - Map, the network topology of the power-supply system is displayed 
on a map. The individual objects/measuring points of the power-supply system, such as generators and lines, 
for example, are shown as icons.

The parameters of the power-supply system shown on the map can be assigned in the tool SIGUARD PDP 
Engineer, see 4.6.1 Overview.

The map is taken from Google Earth and the objects of the power-supply system are shown.  The navigation 
and the zoom functions are standard functions of Google Earth. In addition, further special functions are avail-
able.

Figure 2-6 Map, Map with Topology of the Power-Supply System

✧ If no map is open yet, click the button  to display the map.

Google Earth is started and appears in the window section SIGUARD PDP UI - Map.

The current status of the objects is displayed in color. The general meaning of the color is:

• Blue
The object is in normal operation, the measured values for this object lie within the defined range, the 
status is OK.

• Yellow
The measured values for this object lie above the limiting value Max1 or below the limiting value Min1, 
the status is not critical yet.

• Red
The measured values for this object lie above the limiting value Max2 or below the limiting value Min2, 
the status is critical.

• Gray
No current measured values are available for this graphical object.

• Edge only
No measuring device is present.
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2.4 Map
You can find a more detailed description of the meaning in the following table.

Setting Options/Displays  

✧ Change the display of the map in the window section SIGUARD PDP UI - Map with the help of the icons.

The following table explains the setting options and displays available in the SIGUARD PDP UI - Map window 
section. 

Table 2-3 Window section SIGUARD PDP UI - Map

Element Setting options

Click this icon on the toolbar of SIGUARD PDP UI to start Google Earth.

Click this icon in order to navigate with the standard functions of Google 
Earth. 
Click this icon in order to select an area on the map.
The measuring points that lie within the selected area are listed under 
Selected measurements.
Click this icon in order to bring an object into the middle of the map sec-
tion.
An object is displayed in the middle of the map section by clicking with 
the mouse pointer on the object.
If you point to a substation symbol with the mouse pointer in this mode, 
the associated measured values are shown in a tooltip.

Click this icon in order to zoom in on an area on the map.

Zoom function: Zoom in

Zoom function: Zoom out

Click this icon, in order to display the legend of the objects.
The legend is explained as follows.
Line
The displayed colors mean: 
Red =The line is overloaded. 
Yellow =The line is heavily loaded.  
Dotted =The line is out of order.  
Blue =The line is operating normally. 
Gray =The values of the line are not captured. 
Generator
The displayed colors mean:
Red =The generator is overloaded. 
Yellow =The generator is heavily loaded. 
Blue =The generator is operating normally. 
Unfilled =The values of the generator are not captured.
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2.4 Map
Figure 2-7 Window section SIGUARD PDP UI - Map with a legend displayed

Substation
The displayed colors mean:
Red =In the substation, a voltage was measured that deviated strongly 
from the rated value. The limiting value Max2 or Min2 was violated.
Yellow =In the substation, a voltage was measured that deviated con-
siderably from the rated value.  The  limiting value Max1 or Min1 was 
violated.
Blue =In the substation, a voltage was measured that is in the normal 
range.
Gray =The substation is out of order. 
Unfilled =The values of the substation are not captured.
Compensator
The displayed colors mean:
Red =The compensator is overloaded.
Yellow =The compensator is heavily loaded. 
Blue =The compensator is operating normally. 
Gray =The compensator is out of order.
Dotted =The values of the compensator are not captured.

Element Setting options
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2.4 Map
Display of island-state detection (ISD) 

If an island is formed between 2 or more substations, then the detected islands are displayed in the map as 
colored areas. The color scale corresponds to that of the diagrams (1st island shown in orange, 2nd island 
shown is blue, etc.).

✧ Open the event list.

✧ Filter this list with Island Detection.

✧ Select an event in order to display the corresponding islanding.

Figure 2-8 Islanding with a certain event
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2.4 Map
Display of power swing recognition (PSR) 

A swing detected in the power system is shown in the map as red circular areas around the substations. The 
circular areas can also be connected by red, rectangular areas, if the swing affects several substations.

✧ Open the event list.

✧ Filter this list with Power Swing Recognition.

✧ Select an event in order to display the corresponding power swing recognition.

Figure 2-9 Power swing recognition with a certain event

You can find further information on the analysis of power swing detection in chapter 2.11.3 Power Swing Rec-
ognition.
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2.5 Chart View
.

In the Chart View window section, you can simultaneously display several diagram groups. The diagram 
groups are separated from one another by horizontal lines. Within a diagram group, the displayed time range 
is identical, for example, values of an instant are listed exactly one below the other. In order to group the display 
of measured values, you can open several Chart views.

The time lines of the diagrams of a diagram group are always scaled identically to ensure comparability of the 
values. Depending on the width of the y-axis label, however, diagrams in different diagram groups can be 
scaled slightly differently.

Depending on whether you drop a measuring point above or below the horizontal line, a new diagram is created 
within the diagram group (when you place the object above the line) or a new diagram group is generated 
(when you place the object below the line).

Every diagram group can contain several Line diagrams but only one Vector diagram.

The Diagram type is determined by the type of the first curve. An analog curve is displayed in a line diagram, 
a phasor in a vector diagram. In order to represent the change in the magnitude of a phasor with time in a line 
diagram without an additional analog value, first create an empty line diagram and pull the phasor into it. To 

generate a blank line diagram, use the  button.

You can display several curves in each diagram. To represent an additional curve in an existing diagram, drag 
and drop a measuring point to the diagram. The curve adapts to the diagram type. A line diagram shows only 
the amplitude of a phasor.

In real time display mode, the curves in a line diagram move to the left. New values are added on the right side. 

Figure 2-10 Chart View, display mode of several curves of a time range

The diagrams display the time range that has been selected with the slider in the PSS Curve window section. 
The cursor position on the time line corresponds to the cursor position in the PSS Curve window section.

In offline mode, a past event can be rerun repeatedly to analyze the underlying dynamic processes. A cursor 
then runs through the line diagrams.
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2.5 Chart View
Parameter of displayed curves 

The measured values displayed are listed with the respective colors next to or above the diagram. The corre-
sponding curve can be shown/hidden via the check box selections.

Right-click an entry in the list to open a context menu. The menu items mean:

• Signals
Use this menu item to show/hide individual curves. 

• Copy to clipboard ....
Select this menu item to copy the diagram to the Microsoft Windows clipboard. 

• Show measure line (only in offline mode)

With this menu item, you can show a horizontal line for a certain measuring point. The precise measured 
value is shown at the intersection of the horizontal line with the diagram.

• Show second cursor (only in offline mode)

With this menu item, you can show a second cursor (vertical line). The difference from the first measured 
value is shown at intersection of this line with the diagram.

• Edit limits
With this menu item, you can open the Limit Editor for this signal. The limiting values are displayed. 

Alternately you can display the limiting values of a curve by double-clicking the corresponding entry in the 
curve list. 

• Show average value (only for line diagrams, no formulas)

With this menu item, an average is generated for every measured value of the curve and the curve is thus 
smoothed. The smoothed curve is identified by [Avg] in the name.

Setting Options/Displays  

The following table explains the setting options and displays for the Chart View window section.

Table 2-4 Window Section Chart View

Element Explanation

Click this element in order to generate an empty line diagram.

A click on the left element successively reduces the height of all dia-
grams (for overview). 

A click on the right element successively enlarges the height of all dia-
grams (for details).

With a click on this element, the average values of the curve are dis-
played (smoothing average generation).

This element is only active in online operation. Click this element in 
order to open a dialog in which you can switch on/switch off the trace of 
the tie point and change the chronological length of the tie point. 

Click this element to start the editor for all limiting values.

Click this element in the Limit Editor to activate changed limiting values 
in the overall system. The color of the PSS Curve bar changes from 
orange to gray.
This element is visible only if a limiting value was changed Limit Editor 
or if the Limit Editor is opened for an individual curve. It is opened by 
double-clicking a curve/legend entry.
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Click this element, in order to change the scale of the y-axis. 

• Axis
The following properties are to be set for the selected axis:

• dynamic
With the setting dynamic, the scaling of the y-axis is always auto-
matically selected such that the displayed curves are displayed at 
the maximum scale.

• maximized
With the setting maximized, the scaling is corrected such that the 
displayed curves are displayed at the maximum scale.

• manual
With the setting manual the scaling of the curves is set to the 
entered minimum and maximum values.

• zero-aligned
If zero-alignment is selected, the y-axis is displayed from the zero 
point and the curves are re-scaled correspondingly.

This element is active only with the setting maximized.
Click this element in order to correct the scaling one time, such that the 
displayed curves are shown at maximum scale.
Click this element to delete the relevant diagram, including all curves 
represented in it. All following diagrams move up by one line.
This element is called by double-clicking a measured value above the 
diagram.
The border color correlates with the curve color.
The element shows the currently valid limiting values for the associated 
curve. You can change and enable/disable the limiting values. Enabled 
limiting values are represented as a horizontal line in line diagrams and 
as a circular line in phasor diagrams.
Effective limiting values are indicated by a blue background. Changed 
limiting values that are not yet effective are indicated by an orange 
background.
When clicking the cross, the element is closed and the changes are 
saved locally.
An active limiting value must be plausible (for example, Max2 > Max1), 
otherwise saving it is rejected. 

Element Explanation
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2.6 Measured Values, Applications and Formulas

2.6.1 Overview
.

In the window section Measurements, applications and formulas, you will find:

• Selected measurements
The list contains measuring points that belong to the selected objects in the window section SIGUARD 
PDP UI - Map.

• All measurements
The list contains all measuring points that are available in the power-supply system. In this list, you can 
also define whether the measuring points are listed in alphabetical order, sorted by unit or type.

• Predefined formulas
The list contains all predefined formulas.

These formulas can be applied to the measured values.

• Voltage stability curves
The list contains special curves (applications), for example, voltage stability curves.

• Statistics
Values that can be displayed in diagrams are gathered for each PMU.

Figure 2-11 Listings of Measuring Points, Measuring-Point Applications, and Formulas

You can define whether these are listed in alphabetical order, sorted by unit or type by clicking once or twice 
on the corresponding column heading.

Up to 10 measuring points/formulas/VSCs/statistics can be displayed in a diagram.

To do this, drag and drop the selected measuring point into the window section Chart View. A measuring point 
of the Phasor type is represented as a vector diagram unless you drag and drop it to a previously created line 
diagram. A measuring point of the Analog type is always displayed as a line diagram. You can insert measuring 
points into existing diagrams of the same type. You can select several measuring points and simultaneously 
drag and drop them into a diagram. 

In the measurements window section, right-click a measuring point of the Phasor type to define it as a refer-
ence phasor or to delete it.
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All phasors displayed in the window section Chart View refer to the reference phasor. This means that all phase 
angles are displayed relative to the phase of the reference phasor.

With the aid of the arrows, you can show or hide the complete window section or a listing.

Information on the use of predefined formulas can be found at 3.3 Displaying Curves. 

2.6.2 Selected Measurements
.

The list Selected measurements contains all measuring points selected in the map. In this way, the number 
of measuring points can be limited to one substation, for example.

Figure 2-12 Listing of the Selected Measuring Points
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2.6 Measured Values, Applications and Formulas
2.6.3 All Measurements
.

The list All measurements contains all measuring points that are available in the power-supply system.

Figure 2-13 Listing of All Measuring Points
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2.6 Measured Values, Applications and Formulas
2.6.4 Predefined Formulas
.

The list Predefined formulas contains all predefined formulas in SIGUARD PDP. These formulas can be 
dragged into a Chart View in order to integrate corresponding measuring points into the formula as a parameter 
and calculate a curve from this. This curve is then shown in the Chart View. Assign a unique name to the cal-
culated curve.

 NOTE

Depending on the selected curve, only certain measured values can be used as input quantities. With some 
formulas, you can use constant values.

 

Figure 2-14 Listing of All Predefined Formulas
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2.6.5 Voltage stability curves
.

The list Voltage stability curves contains all measuring points in the power system with which voltage stability 
curves can be calculated using the application VSC.

Figure 2-15 Listing of All Measuring Points for Calculation of the VSCs
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2.6.6 Statistics
.

6 statistical values which can be displayed as diagrams are gathered for each PMU:

• Count of received errors
Number of errors received per parameterizable counting period.

• Count of received frames
Number of telegrams that are transmitted from the PMU to the SIGUARD PDP Server per counting period 
(for example, 600).

• Count of telegram errors
Number of the PMU status flags contained in each telegram.

• Count of timestamp errors
Number of errors with deviation from the regularity of timestamps per repetition rate.

• Count of timestamp window error
Number of errors with deviation of timestamps per time slot (tolerance). The deviation can lie in the past 
or in the future.

• Latency
Measurement of maximum latency. The latency is the time difference between the sending of the mea-
sured values from the PMU to the arrival at the SIGUARD PDP Server.

 NOTE

Take note that the absolute latency is analyzable only if the PDP Server is time-synchronized. If the server is 
not time-synchronized, you can only observe the difference between latencies of different PMUs.

 

Figure 2-16 Listing of Statistical Measured Values
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2.7 Alarm List and Event List

2.7.1 Overview
.

SIGUARD PDP UI messages can be shown in the form of lists:

• Alarm list
The Alarm list contains only appearing messages.

• Event list
The event list contains all messages (appearing and disappearing messages).

The alarm list and the event list are opened in the lower right window section within SIGUARD PDP UI. The 
window can be separated and enlarged or inserted into another position in the SIGUARD program window (see 
2.8 Arranging Program Interface).

The alarm list or event list contains alarms or events that occurred in the time range that is set by the left and 
right limitation of the PSS curve.

2.7.2 Alarm List
.

Open a window for an alarm list in SIGUARD PDP by clicking the button .

Figure 2-17 Alarm list

The alarm list is comparable to an EXCEL table. It contains the following columns:
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Table 2-5 Parameters of the Alarm list

For notes on editing the Alarm list, see 2.7.4 Editing of Messages.

2.7.3 Event List
.

Open a window for an event list in SIGUARD PDP UI by clicking the button .

Figure 2-18 Event list

A horizontal line marks the current point in time (offline operation). Events which lie in the future (from the point 
of view of the current time cursor) are colored gray.

The time cursor (horizontal line) can be moved. Select the corresponding row and call up the context menu 
Move > locator.

The event list is comparable with an EXCEL table. It contains the following columns:

Element Explanation
Time Point in time at which the warning indication was tripped in hours:min-

utes:sec 1/1000 (time stamp). The warning indications can be sorted ac-
cording to time rising or falling, by clicking the heading Time with the left 
mouse button. The column is always shown.

Date Date of tripping the warning indication in the format: Year-Month-Day (for 
example, 2010-09-21)

Name Name of the physical PMU or the measuring channel that triggered the 
warning indication.

Event element Element that triggered the warning indication (for example, PMU device, 
Channel, Island Detection, or Power Swing Recognition)

Incidence Description of the event (for example, Limit Low 1 violated (limiting 
value shortfall) or PMU device communication failure or License 
Error)

Message Additional information (for example, size of the measured value: Value 
379981 V, since the lower limiting value 1 of 380 000 V was undercut).
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Table 2-6 Parameters of the Event list

For notes on editing the event list, see 2.7.4 Editing of Messages.

2.7.4 Editing of Messages
.

For a better overview of the alarm list and the event list, the table can be edited.

Editing Columns
• Hiding columns

All columns with the exception of the column Time can be hidden. Open the context menu in the header. 
Only marked headers are displayed (shown).

• Column sequence
You can move individual columns by dragging the header horizontally to another place in the table, thereby 
changing the column sequence.

• Change column widths
All columns can be changed widthwise by dragging the column edge. 

Sorting According to Column Contents

The alarm list and the event list can only be sorted according to time (rising or falling). For this, click the header 
of the column Time.

Filtering According to Column Contents

In the column Name, Event element (Element that triggered the alarm) and Incidence (event) are available 
in the selection lists according to whose parameters the lists can be filtered.

Copying the Contents of Lists

Select a line and press <CTRL-A>, in order to select all lines, and <CTRL-C>, in order to copy lines into the 
clipboard. Open the corresponding application (for example, Microsoft Word Pad) and press <CTRL-V>, in 
order to copy the contents of the clipboard into the file.

Element Explanation
Time Point in time at which the event indication was tripped in hours:min-

utes:sec 1/1000 (time stamp). The event messages can be sorted ac-
cording to time rising or falling. The column is always shown.

Date Date of tripping the event indication in the format: Year-Month-Day (for 
example, 2010-09-21)

Name Name of the physical PMU or the measuring channel that triggered the 
event indication.

Event element Element that triggered the event indication (for example, PMU device, 
Channel, Island Detection, or Power Swing Recognition)

Incidence Description of the event (for example, Limit Low 1 violated (limiting 
value shortfall) or PMU device communication failure or License 
Error)

Transition Display whether an appearing or disappearing event indication is upcom-
ing.

Message Additional information (for example, size of the measured value: Value 
379981 V, since the lower limiting value 1 of 380 000 V was undercut).
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2.8 Arranging Program Interface 
.

You can arrange the Program Interface of SIGUARD PDP according to your needs. You can display all 
window sections in one window or distribute it across several windows. 

The window sections Menu, Toolbar, and PSS Curve make up the main window, and they can be opened only 
once.

The window sections Chart View, Event list, Alarm list, and PSRs can be opened several times. The window 
sectionSIGUARD PDP UI - Map can be opened only once.

All Window Sections in One Window

In the initial start of SIGUARD PDP UI, the PSS curve is displayed in the main window. Further components 
can be opened with a click on the symbols on the top left. The components, for example, the map and lists, are 
also inserted into the main window. 

Figure 2-19 All Window Sections in One Window

Window Sections on Several Monitors

When using 2 Monitors you can distribute the window sections between these, for example, in 2 windows. But 
you can also display window sections on additional monitors.

You can distribute window sections between 2 windows as follows:

✧ Select a window section, for example, the map, with the mouse and drag it out from the main window to 
the second monitor. 

✧ Drag additional window sections into the window on the second monitor. 
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✧ Arrange the window sections in both windows according to your needs. 

The desired display is shown in the 2 windows. You can place the 2 windows in 2 monitors. 

Figure 2-20 Main Window with Chart View

Figure 2-21 Second Window with Map and Event List
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Save User Interface 

When closing, SIGUARD PDP UI saves the current display of the program interface as a favorite with the des-
ignation StartUpFavorite. When reopening, the program interface of SIGUARD PDP is shown in the saved 
display.

You can also save additional displays as Favorites. 

You can save a display as a favorite as follows:

✧ Click in the toolbar on the icon Save Favorite. 

The Save Favorite dialog is opened.

Figure 2-22 Enter Name for Favorites

✧ Give the favorite a name and close the dialog with Save.

The favorite is saved under the name entered.

 NOTE

The following are not saved in the favorite: 
• The list of measuring points under Selected measurements.
• The calculated values generated and displayed by a predefined formula (under Predefined formulas).

 

Call up Saved User Interface

You call up a saved user interface as follows:

✧ Select the desired user interface under Favorite name. 

The saved user interface is displayed.

Deleting a Saved User Interface

To delete a saved user interface, proceed as follows:

✧ Select the desired user interface under Favorite name. 

The saved user interface is displayed.

 NOTE

A deleted user interface cannot be restored after deletion.

 

✧ In the toolbar, click the icon Delete Favorite.
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2.9 Limit Editor 
.

In the Limit Editor, you define the limiting values/thresholds that are to play a role in the evaluation. All con-
figured measuring points are listed.

The limiting values/thresholds can be defined in the tool SIGUARD PDP Engineer, see 4.4 Phasor Measure-
ment Unit (PMU).

Starting Limit Editor 

Start the Limit Editor as follows:

✧ In the window section Chart View, click the top left button .

You can enter limiting values for all measuring points and subsequently change them (see 2.5 Chart View).

3 minimum and 3 maximum values are possible for each measuring point. Enable the limiting values to ensure 
that they are effective. Measuring points for which no limiting values are effective are not considered when cal-
culating the system status (Power System Status).

Figure 2-23 Limit Editor, Definition of the Limiting Values

Entering Limiting Values

✧ Set the parameters for the limiting values.

6 columns are available for entering the limiting values:

• Min1, Min2, Min3
In these columns, enter the lower limiting values/threshold. Min3 is the lower/most critical value. Min1 is 
the upper/least critical value.
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• Max1, Max2, Max3
In these columns, enter the upper limiting values/thresholds. Max1 is the lower/least critical value. Max3 
is the upper/most critical value.

Copying Limiting Values and Activations

Copy limiting values and activations as follows:

✧ While keeping the left mouse button pressed, select the limiting values and activations by dragging with 
the mouse.

✧ Right-click in the selection and select Copy from the context menu.

✧ Right-click the cell, which corresponds to the upper left corner of the area to be inserted, and select Paste 
from the context menu.

Effect of limiting values:
• The limiting values affect the coloring in the geographical overview display in Google Earth. The color of 

the stations indicates whether the voltages have violated limiting values. The color of the lines indicates 
whether the currents have violated limiting values.

• The limiting values are drawn into the line and vector diagrams.

• The limiting values influence the status of the curve in the PSS Curve window section.

Setting Options/Displays  

✧ Make settings in the Limit Editor with the help of the buttons and selection lists.

The following table explains the setting options and displays of the Limit Editor.

Table 2-7 Limit Editor Window Section

Element Explanation
Use this element to select which measuring points are to be listed: 
• Selected measurements

The measuring points preselected in the map are listed.
• All measurements

All measuring points are listed.
• Application data

for example, data from power swing recognition (PSR)
• Statistics

Measured values from the PMUs
Click this element to activate changed limiting values in the overall 
system. The Limit Editor is closed.

Enter the limiting value and enable it by checking it. Subsequently, ac-
tivate the changes.

Click this element to activate changed limiting values in the overall 
system. The Limit Editor is closed.

Click this element to save the changes locally and to exit the Limit 
Editor. The changes are only effective on the local computer.

Click this element to discard the changes and to exit the Limit Editor.
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2.10 Reporting
.

In order to document an event, diagrams can be stored in the clipboard and inserted from there, for example, 
into Microsoft Word. 

Copying a Diagram into the Clipboard

You can copy a diagram into the clipboard as follows:

✧ Right-click the diagram in the Chart View window section.

✧ Select Copy to Clipboard ... from the context menu.

Figure 2-24 Export to metafile

✧ Enter the image size and click OK to confirm. 

Export Values

You can export the measured values of the time range selected with the sliders from the SIGUARD Archive into 
a CSV file. Then edit this CSV file further with a spreadsheet program.

You export measured values into a CSV file as follows:

✧ Switch to offline mode.

✧ In the window section PSS Curve, set the desired time range with the sliders. 

✧ Select the menu item File > Save to CSV.... 

✧ Enter the file name in the dialog Save Csv.

✧ Click Save.

The measured values are exported into a CSV file. The path and the directory were defined during the instal-
lation of SIGUARD PDP.

 NOTE

Note that it may not be possible to process the file with common spreadsheet programs if it contains more than 
255 columns and more than 65,536 lines. For each phasor, you need 3 columns; for each analog value, you 
need 2 columns, plus an additional column for the time stamp. 65,536 lines amount to 1 h 39 min at 10 values 
per second or 21 min at 50 values per second.

 

You can determine the quality of the measured values from the CSV file, see the following example. 
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Figure 2-25 Extract from a CSV Export File
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Table 2-8 Significance of the Quality Code in an Exported CSV File

Abbreviation Meaning Source of the quality code
COE PMU communication error SIGUARD PDP Server
CTO Collector time-out SIGUARD PDP Server
SC1 Time synchronization 1 PMU
SC2 Time synchronization 2 PMU
COC Configuration change PMU
TGR Transfer trigger PMU
CLF Time error PMU
NSY PMU not synchronized PMU
ERR PMU error PMU
DAI PMU data invalid PMU
DAM PMU data missing PMU
OOS Out of service SIGUARD PDP Server
L3V Limit violation Minimum 3 SIGUARD PDP Server
L2V Limit violation Minimum 2 SIGUARD PDP Server
L1V Limit violation Minimum 1 SIGUARD PDP Server
H1V Limit violation Maximum 1 SIGUARD PDP Server
H2V Limit violation Maximum 2 SIGUARD PDP Server
H3V Limit violation Maximum 3 SIGUARD PDP Server
DNF Data not found in archive SIGUARD PDP Server
PCE Calculation library error SIGUARD PDP Server
ADI Application data invalid SIGUARD PDP Server
DAS Data suspect SIGUARD PDP Server
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2.11 Applications

2.11.1 Overview
.

In SIGUARD PDP UI, various applications can be executed:

• Island Detection in Networks (ISD)

• Recognition of swings in the network (PSR)

• Display of Voltage Stability Curve (VSC)

The configuration and parameter assignment of individual applications is done in SIGUARD PDP Engineer, 
see 4.7.1 Overview.

2.11.2 Island State Detection (ISD)
.

Island detection in SIGUARD PDP uses the measured values present in every PMU Frequency (f) and Fre-
quency Changing Speed (df/dt). 

2 component applications are present:

• Static Island Detection
Here, all frequency values are compared with one another. 3 different conditions are distinguished:

- If the difference between 2 frequency values lies below one of the lower limiting values, no islanding 
is detected.

- If the difference between at least 2 neighboring frequency values lies between the lower and upper 
limiting values, potential islanding is reported. This notification can be understood as a warning indi-
cation.

- If the difference of at least 2 neighboring frequency values lies above an upper limiting value, then, 
with sufficient certainty, islanding is detected and a corresponding notification is generated. This no-
tification can be understood as a warning indication.

• Dynamic Island Detection
Here, all rates of frequency change are compared with one another. 2 conditions are distinguished here:

- If the difference between at least 2 neighboring values of the rate of frequency change lies under the 
limiting value, then there is no islanding.

- If the difference between at least 2 neighboring values of the rate of frequency change lies above a 
limiting value, then islanding is possibly present or is in the process of arising. This notification can be 
understood as a warning indication.

For the parameter assignment of the application Island State Detection, see 4.7.2 Island State Detection 
(ISD).
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Display of Island Detection in the Event or Alarm List

All notifications generated by SIGUARD PDP ISD are to be found in the event list. When potential or certain 
island formations are detected, corresponding entries are written into the alarm list.

Figure 2-26 Alarm List, Filtered according to the Event Element Island Detection

In the filtered alarm list, the detected islands are displayed with the event ISD network split or ISD potential 
network split. An ISD network split in the Message column of which Zone 1, Zone 2 and Zone 3 are entered 
is a definite event for island detection. This means that 3 islands were detected.

 NOTE

The displayed values in the respective ISD event for frequency und frequency increase are averages of the 
PMU values over a time constant given in the SIGUARD configuration file. Consequently, they deviate from the 
respective PMU values on the measuring time point given in the ISD event. Moreover, if several PMUs or fre-
quency measuring points lie in a zone, then a further averaging of its average values occurs.
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Display of Island Detection on the Map

Various colored areas corresponding to the number of recognized islands are displayed on the map. If only one 
substation is contained in the island, then the area around the substation is displayed as a square. If there are 
several substations, then the area is displayed as a polygon with the substations as corners.

The colored display correlates with the colors of the Chart Views (1st island = orange, 2nd island = blue, 3rd 
island = green, etc.).

You can find further information on parameterization in chapter 4.7.2 Island State Detection (ISD).

Figure 2-27 Map with Detected Islands
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2.11.3 Power Swing Recognition
.

A detected active-power swing is displayed in various window sections at the user interface (UI):

Display of the Power Swing Recognition on the Map

If a power swing measured in terms of angle difference is present, the locations of the 2 PMUs involved are 
circled and the connection line is inserted between them (see connection Mülheim – Nürnberg in the following 
figure). If a power swing measured in terms of active power is present, then the PMU where the measurement 
was made is present is marked with a circle (see Copenhagen in the following figure). The color of the icon 
matches the color in the previous figure.

Figure 2-28 Power Swings on the Map
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Display of Power Swing Recognition in Power Swing Analysis

All notifications generated by SIGUARD PDP PSR can be found in the event list. Corresponding entries are 
written in the alarm list in the case of recognized power swings.

Figure 2-29 Alarm List Filtered According to the Event Element Power Swing Recognition

In the filtered alarm list, the recognized power swings are displayed with the corresponding event. 

All jobs configured with SIGUARD Engineer and their corresponding modes are listed in the window section-
Power swing analysis. Picked up modes are displayed with icons identified by colors. The colors of the icons 
correspond to the color in Figure 1-10.

Figure 2-30 Interface Components for Power Swing Analysis 
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Table 2-9 Interface Components for Power Swing Analysis 

Display of Power Swing Recognition in Power Swing Recognition Overview

Using drag and drop from the Power swing analysis, this diagram can be displayed in the Chart View window 
section. The diagram shows all recognized power swings for the current time point in the frequency damping 
diagram.

Figure 2-31 Recognized Power Swings Diagram Overview (Frequency over Damping)

Element Explanation
Power Swing Recognition
overview

Click the element and drag it into a Chart View in order to generate a 
PSR Overview.
Click this element in order to close the entire PSR tree structure.

Click this element in order to open the first hierarchy of the PSR tree 
structure.

Click this element in order to open the entire PSR tree structure.

Click this element in order to display the name of the measuring points 
in the PSR tree structure or switch to display of the parameter names 
again.
Gray marking
No power swing was recognized.
Yellow marking (1)
PSR notified power swing
A recognized power swing was reported.
Bright orange marking (2)
PSR distinct power swing
A distinct power swing was recognized and reported.
Dark orange marking (3)
PSR critical power swing
A critical power swing was recognized and reported.
Red marking (4)
PSR undamped critical power swing
An undamped critical power swing was recognized and reported.
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Display of the Input Curves in the Chart View

The input curves (active power or phase angle) and the quantities determined therefrom for a recognized mode 
(frequency, magnitude damping ratio and DOE) in the Power Swing Analysis window section can be dis-
played in the Chart View window section.

 NOTE
Take note of the following:
• A separate license is required for the application PSR. If you have not purchased a PSR license, then this 

application cannot be run.
• In order to avoid an overload of the server, control the computing time needs of PSR.exe, before you define 

other PSR jobs. You can observe the computing time needs in percent on the Processes tab of the Windows 
Task Manager. The application should not consume more than 50 % of the calculation module (approx. 
12.5 % for a four-ore processor).

• A patent is pending for the algorithms of the PSR.

 

You can find further information on parameterization of the PSR in chapter 4.7.3 Power Swing Recognition 
PSRs.

2.11.4 Voltage Stability Curve (VSC)
.

SIGUARD PDP offers the option to calculate and output a voltage stability curve (P-V curve) in the 
SIGUARD PDP UI.

2 different modes are supported:

• Measurement of the voltage stability curve of a line with a PMU at the beginning and end, respectively 
(voltage and current measurement)

• Measurement of the voltage stability curve of a line with a PMU at the beginning of the line (voltage and 
current measurement) and the associated 2-port parameters.

If the line is equipped with only one PMU, the 2-port parameters of the line (Resistance R [Ω], Reactance X [Ω], 
Conductance G [µS], and Susceptance B [µS]), are used for the calculation of voltage and current at the end 
of the line, see following illustration.

Figure 2-32 2-Port Equivalent Circuit of the Transmission Line
(1) R = Resistance
(2) X = Reactance
(3) G = Conductance
(4) B = Susceptance
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The current load admittance is calculated with the measured or calculated voltages and currents in the endpoint 
node of the line. The corresponding line load is represented as an operating point on the curve (red cross) (see 
following illustration). The voltage stability curve itself arises through variation of the complex load admittance 
in the endpoint node of the line from zero to infinity. The recalculation of the curve is performed with each 
update of the SIGUARD PDP UI.

Figure 2-33 Example of a Voltage Stability Curve

All parameterized voltage stability curves (VSCs) are listed in the lower right window section in SIGUARD PDP 
UI under Applications - Voltage stability curves. By dragging a voltage stability curve, for example, MlhM -
> NbgH, with the mouse into the window section Chart View beneath the timing diagram, the voltage stability 
curve is displayed (see 3.3 Displaying Curves).

A red cross marks the current operating point. In the figure above, the critical point is nearly reached. With min-
imally higher power, the stability criteria are violated and a network disconnection can result.

 NOTE

If controllable reactive power sources are present in the endpoint node of the line or in its vicinity, the curve 
shape of the voltage stability curve is not constant, rather it varies with the degree of the reactive power fed in. 
Therefore no quantitative statement can be gained from the diagram as to how much additional transferable 
power can be transported via the line. Nonetheless, a qualitative evaluation of the voltage stability curve is help-
ful, as it allows the user the option of evaluating the distance to maximum power.

 

For the parameter assignment of the voltage stability curves, see 4.7.4 Voltage Stability Curve (VSC).

■
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3.1 Sample Event 
.

A simple example is given to illustrate the handling of SIGUARD PDP.

In this example, a time range is selected from the archive that is displayed as critical in the PSS Curve window 
section. The essential curves for this time range are to be displayed and analyzed. The analysis is performed 
in offline mode. The goal of the analysis is to find out why the PSS curve keeps going into the red range.

Procedure

The suggested procedure is to illustrate the individual steps for examining and assessing an event.

Proceed as follows:

• Select the time range in which the event to be examined is found.

• Display the essential curves to the event.

• Export the time range into the permanent archive.

• Import the time range from the permanent archive. 

• Create and print a report.
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3.2 Selecting the Time Range 
.

The analysis of a time interval can only be performed in offline mode. In offline mode, the information from the 
devices is still stored in the archive and can later be viewed and analyzed. 

In the window section PSS Curve, select the time range you want to display and analyze.

You can see the temporal progression of the selected range in the window section SIGUARD PDP UI - Map.

Switch on Offline Mode 

✧ Click the Go offline button to set Offline mode.

The following figure shows the status curve with several critical ranges. These are displayed in red.

Figure 3-1 Power System Status, Curve with Critical Ranges

Selecting the Time Range 

✧ Set the length of the visible time range with the list box .

✧ Scroll with the arrows to the desired location in the archive.

✧ Move the sliders on the time line to the desired points using the mouse.

The time range between the sliders is represented in the diagrams.

The selected time range is displayed in the From and To boxes.

Figure 3-2 Power System Status, Selecting the Time Range
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Starting the Sequence 

✧ Click the button  in order to position the cursor at the left edge of the selected time range.

✧ Click the button  in order to run the time range.

On the map (SIGUARD PDP UI - Map window section), you can see the projected sample project. It consists 
of 4 substations/measuring points and associated high-voltage lines. The coloring of the objects changes, de-
pending on the state at different instants. 

The default object coloring is blue. An exceedance of the first limiting values is displayed in yellow, a violation 
of the second limiting value is displayed in red. 

In the figure, the line between the measuring points Mülheim and Paris is clearly critical. The cause is to be 
found below. 

Figure 3-3 SIGUARD PDP UI - Map, Following the Progression

Stop Sequence 

✧ Click the  button to stop the sequence.

Selecting a Specific Instant 

✧ In the selected time range, click on a point to display the state at this instant.

On the map, you see the objects colored depending on the state at this instant.
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3.3 Displaying Curves 

Map with Objects

In the SIGUARD PDP UI - Map window section, you see a map with the power-supply system inserted. The 
power-supply system consists of objects, for example, generators and lines. You can display tooltips for the 
individual objects. Furthermore, a legend is available.

Display Tooltips 

You can call tooltips for the individual objects on the map. Measured values are displayed for the respective 
objects.

✧ Click the  button to display tooltips.

✧ Place the cursor over an object to display the tooltip. 

The available information on the object is displayed.

Figure 3-4 SIGUARD PDP UI - Map, Display Tooltip
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Showing the Legend 

The objects of the map and their coloring are described in a legend.

✧ Click the Legend button to display it. 

The legend is shown.

Figure 3-5 SIGUARD PDP UI - Map, Display Legend

For further information on the objects in the map, see 2.4 Map

Selecting Objects 

On the map, select the objects for which you want to display curves.

✧ Click the  button.

✧ In the SIGUARD PDP UI - Maps window section, select an area around the objects for which you want to 
perform an analysis.

The selection is shown. 
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Figure 3-6 SIGUARD PDP UI - Map, Select Objects

✧ In the right side of the window, click the arrow above Measurements, Applications, Formulas. 

The list of measured values is displayed.

The measured values available for the selected objects are listed in Selecting Measurements. In the next 
step, you can display curves for these measured values. 

Figure 3-7 Measurements, Listed Measured Values
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Zoom in on the Map Section 

You can enlarge the display of a map section. Details of the power-supply system are visible in the enlarged 
display. For example, multiple lines become visible that have previously only been represented as one single 
line.

The details are only displayed if they have been previously parameterized.

✧ Click the  button to zoom in on the map section. 

The map is displayed in an enlarged form.

Figure 3-8 SIGUARD PDP UI - Map, Enlarged Map Section

✧ Click the  button to undo the enlargement.
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Displaying Curves 

You can now represent the available measured values as curves in diagrams.

To analyze the event, create the following charts:

• A timing diagram with currents

• A vector diagram with voltages

• A diagram with a voltage stability curve

✧ In the Chart View window section, click the  button to generate a blank line diagram.

✧ Drag and drop 2 measured currents with the mouse pointer, for example, NbgH/I1 and MlhM/I1, to the 
generated diagram.

You can select several measured values in the list and simultaneously drag them into a diagram.

These measured values are current phasors of the measuring points Nuremberg and Mülheim. The timing 
diagram represents the time characteristic of the absolute current values, but not their phase. 

As a time range, the time range selected in PSS Curve is displayed in the window section. 

Figure 3-9 Timing Diagram, Currents

The figure shows considerable changes of the amperage and damped oscillations. The amperage changes are 
caused by connecting and disconnecting a heavy load. The oscillations indicate a power swing.

Create a diagram with voltage phasors for further examination.

In the Chart View window section, you can scroll down to insert and display further diagrams. 

✧ Drag and drop a voltage phasor, for example, NbgH/U1, to the Chart View window section below the 
timing diagram.

A vector diagram with a voltage vector is displayed.

✧ In addition, drag and drop a voltage phasor, for example, MlhM/I1, to the vector diagram.  
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Figure 3-10 Vector Diagram, Voltages

The vector diagram shows the characteristics of the phase angles of the voltages, that is whether there is a 
phase displacement and how large this difference is. Furthermore, it can be seen whether the phase between 
the voltages increases or decreases or remains the same. This enables you to derive, for example, whether 2 
generators oscillate against each other.

A voltage stability curve can provide additional information.

The voltage stability curves are listed in Applications.

✧ Drag and drop a voltage stability curve, for example, MlhM -> NbgH, to the Chart View window section 
below the timing diagram.

A diagram with the voltage stability curve is displayed. 

Figure 3-11 Diagram with Voltage Stability Curve

The voltage stability curve displays the voltage over the power at a specific instant. In the figure, the critical 
point has almost been reached. If the power was slightly higher, stability criteria would be violated and a dis-
connection could occur.
SIGUARD PDP Phasor Data Processing, Manual
E50417-H1076-C419-A3, Release 11.2011

72

http://siemens-russia.com/


Working with SIGUARD PDP UI
3.3 Displaying Curves
Displaying Measured Values in the Diagram

The measured values can only be displayed in the offline mode.

✧ Move the mouse pointer over the diagram.

✧ In the context menu, select Show measure line > <Measured value>.

Figure 3-12 Showing a Measuring Line (Horizontal Line)

A horizontal line is shown in the color of the diagram. The current measured value is displayed at its intersection 
with the diagram. In the time line, the date and time of day are shown for the cursor position.

✧ In the context menu, select Show second cursor.
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Figure 3-13 Showing a Second Cursor (Vertical Line)

A second cursor (gray vertical line) and an additional horizontal measuring line are shown. At the intersection 
with the diagram, the difference from the first measured value is displayed. In the time line, the time difference 
from the first measured value is displayed at the position of the second cursor.

Displaying Average Values of a Diagram

The average value can be generated only for line diagrams.

✧ Display a curve, for example:

Figure 3-14 Diagram without Smoothing Average Generation
SIGUARD PDP Phasor Data Processing, Manual
E50417-H1076-C419-A3, Release 11.2011

74

http://siemens-russia.com/


Working with SIGUARD PDP UI
3.3 Displaying Curves
✧ In the context menu, select Show average value.

Figure 3-15 Diagram with Smoothing Average Generation

The line diagram is displayed smoothed. The name of the measuring point is followed by [Avg] (average).
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Hiding the Map 

✧ Click the X in the upper right of the window SIGUARD PDP UI - Map to hide the map. The display of the 
Chart View window section is enlarged. 

You can also pull the component Chart View out of the main window and position and zoom in anywhere on 
the desktop.

Figure 3-16 Chart View, Hidden Map
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Changing Limiting Values 

The limiting values can be shown and edited to the right of the diagram.

✧ Above the diagram, double-click a measured value to display its limiting values.

✧ Change a limiting value.

Figure 3-17 Changed/Configured Limiting Value

The old limiting values are displayed as a tooltip. After changing a limiting value, the background of the limiting 
value is displayed in orange. 

✧ Click the  button to save and activate the changed limiting value.

The background of the limiting value becomes blue.
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Opening the Limit Editor  

✧ Open the Limit Editor by clicking the  button.

Figure 3-18 Limit Editor

It lists all measured values with the associated limiting values. You can change and enable/disable the limiting 
values.

✧ Enter new limiting values.

✧ Activate the changed limits with a check.

✧ Activate the changed limiting values by selecting Save Limits. 

The Editor is exited.
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Using Predefined Formulas 

A number of predefined formulas are available in Formulas. These formulas can be applied to measured 
values.

Use predefined formulas as follows:

✧ Drag and drop the desired formula, for example, ActivePower, in the Chart View window section.

A dialog is displayed in which you have to enter the parameters necessary for the new curve.

Figure 3-19 Inserting a Predefined Formula 

✧ In Measurement name, enter any name for the new curve. 

✧ Drag and drop measuring points (voltage phasor and associated current phasor) from the Measurements 
window section to the Measurement 1 and Measurement 2 text boxes.

✧ In Factor, enter a decimal value.

The curve is multiplied with this value. Typically this Value is 1. When calculating power this factor can deviate 
since it depends on the measurement (phase-to-phase voltage or phase-to-ground voltage).

Figure 3-20 Entering Parameters for Formula

✧ After entering the last parameter press the key Enter on the keyboard.  

The diagram with the calculated curve is displayed.
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3.3 Displaying Curves
Figure 3-21 Diagram with Calculated Curve
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3.4 Export and Import of Time Ranges

3.4.1 Exporting of Time Ranges
.

In SIGUARD PDP UI, measured data are continuously saved in a ring archive. If the ring archive is full, earlier 
measured data are overwritten and are lost. To prevent this, time ranges and the measured values contained 
in them are saved in a permanent archive. These data can also be loaded again and are available for evaluation 
purposes.

Additionally, time ranges and the measured values contained in them can be saved in CSV format (comma-
separated value). This format can, for example, be opened in a spreadsheet and further processed.

Importing is not possible here. However, a CSV export from a permanent archive can be performed.

Proceed as follows:

Permanent Saving as Time Ranges

✧ Select the menu File > Save time range....

The Save time range dialog is displayed.

Figure 3-22 Save Time Range Dialog

The beginning point in time Locator left and the final point in time Locator right are automatically displayed 
in the dialog and cannot be changed.

Changing the time range is possible only in the PSS Curve window section.

✧ In the Time range entry field, enter the name of the time range (for example, TimeSlice_01) that you want 
to save.

✧ Click the button Save, to save the time range.

The time range is possibly stored as several files and directories.

 NOTE

Saving can last several minutes even though the window has already been closed. The amount of time required 
for saving depends on the amount of the data that must be written in the permanent archive, and on the length 
of the time range you have selected.
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Saving Time Ranges in CSV Format

✧ Select the menu File > Save to Csv....

The Save Csv dialog is displayed.

Figure 3-23 Dialog Save Csv

The beginning point in time Locator left and the final point in time Locator right are automatically displayed 
in the dialog and cannot be changed.

Changing the time range is possible only in the PSS Curve window section.

✧ Enter the file name in the entry field File name.

✧ Click the button Save, to save the time range in CSV format.

The export directory is on the server and was defined during the installation. From a UI, you can also find the 
directory under the path \\<servername>\SIGUARD_Export in order to copy or further process the export files.

 NOTE

Saving can last several minutes even though the window has already been closed. The amount of time required 
for saving depends on the amount of the data that must be written in the permanent archive, and on the length 
of the time range you have selected.
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3.4.2 Importing Time Ranges
.

Time ranges can be selected again and are available for evaluation again. They are no longer loaded into the 
ring archive.

Loading Time Ranges

✧ Select the menu File > Load time range....

The Load time range dialog is displayed.

Figure 3-24 Load Time Range Dialog

All available time ranges are displayed with name, start, and end time in a list format. The size of the window 
can be changed.

 NOTE

The time range is not displayed in the list, until the export from the ring archive into the permanent archive has 
finished completely.

 

✧ Select the time range that you would like to view/evaluate.

✧ Confirm your selection by clicking the OK button.

The loaded time range with the corresponding measured values is displayed in the PSS Curve window section.

You can leave this display from the permanent archive by selecting new data from the permanent archive or by 
displaying current values in online Mode.
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3.4.3 Deleting Time Ranges
.

Time ranges and the measured values contained in them, which were saved in the permanent archive can be 
deleted selectively.

Deleting a Time Range

✧ Select the menu File > Delete time range....

The Delete time range dialog is displayed.

Figure 3-25 Delete Time Range Dialog

All available time ranges are displayed with name, start, and end time in a list format. The size of the window 
can be changed.

✧ Select the time range that you would like to delete.

 NOTE

Time ranges can only be deleted individually. 

Deleted time ranges cannot be restored.

 

✧ Confirm your selection by clicking the Delete button.

The time range with the corresponding measured values is deleted and the dialog is closed.
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3.5 Conclusion from the Analysis
.

The analysis of the sample event leads to the following result:

• The PSS Curve is in the red range due to exceeded current limiting values, see Figure 3-1.

• The cause for the exceedance is the periodic connection of a high load.

• The periodic connection of a high load causes power oscillations that are well damped, see Figure 3-21.

• The current limiting value is briefly exceeded, see Figure 3-9.

• So that undesired protection trips do not arise, the protection settings of the line must be checked. 
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3.6 Creating and Printing Reports 
.

Using the Copy to Clipboard function, you can create, save, and print reports. To do this, insert the diagrams, 
for example, into Microsoft Word and comment on them.

✧ Right-click the diagram in the Chart View window section. 

✧ Select Copy to Clipboard ... from the context menu.

Figure 3-26 Settings for the Metafile

✧ In the next dialog, enter the image size and confirm with OK.

✧ Open a blank document or a self-prepared report template using the text editor.

✧ Use <CTRL> + <V> to insert the clipboard contents into the document.

✧ Open the event list or the alarm list.

✧ Select the relevant messages (click them individually or select them with Ctrl-A) and copy the messages 
with Ctrl+C into the clipboard. 

✧ Insert the events or alarms into the document with Ctrl+V.

✧ Add your own text as comments. For this, use the default settings of the text editor. 

✧ Save the document and print it.

■
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4.1 Overview
4.1 Overview

Application of SIGUARD PDP Engineer

SIGUARD PDP Engineer is the parameterizing and settings tool for SIGUARD PDP. You can set up and 
change the function of SIGUARD PDP with it. The following tabs are available for editing:

• PMU
Add, duplicate, change, or delete physical and logical PMUs.

Adding or changing measuring points for existing or new PMUs.

• Calculation
Add, duplicate, change, or delete calculated values.

Assign parameters of calculated values with factor and formula that uses the input measured values from 
the measured and calculated values.

• Graphics
Add, duplicate, or delete elements for graphical representation of power-supply systems.

Use of Google Earth functions.

• Application
Adding, duplicating, deleting, and parameterization of various applications:

- Voltage Stability Curve (VSC)

- Island State Detection (ISD) in networks

- Swing recognition in networks (Power Swing Recognition PSR)

• Communication
Adding, duplication, deletion, and parameterization of communication via various interfaces:

- C37.118

Creation of PDC server and logical PMUs and configuration of the measuring channels

- ICCP

Parameterization of the communication settings, assignment and parameterization of measuring 
points and assignment of event objects.

- OPC

Parameterization of the OPC servers and assignment and parameterization of the measuring points.

Installation

The tool SIGUARD PDP Engineer is available on DVD and is installed on the target computer together with 
SIGUARD PDP UI (see Administrator Manual, System installation).
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4.1 Overview
Program Window

The main window of SIGUARD PDP Engineer is composed of the following window sections:

Figure 4-1 Schematic Representation of the Program Window of SIGUARD PDP Engineer

 NOTE

You can change the individual windows sections in the direction of the arrow by dragging the boundary line.

 

• Menu
Via the menu you call up general functions (see 4.2 Menu).

• Toolbar
Via the toolbar you call up functions, which can be used within a project (see 4.3 Toolbar).

• Tabs
Via the tabs you select various configuration and parameterizing options.

Depending on the selected tab, corresponding window sections and functions are available to you (see 
4.4 Phasor Measurement Unit (PMU) to 4.8.4 OPC).

• Overview
In the left window section, the tree structure of the existing elements for the selected tab are shown.

• Parameters/Properties
In the middle window section, the parameters and/or properties of the selected element are shown.
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4.1 Overview
• Lists
In the right window section, lists are shown depending on the selected tab (for example, measured and 
calculated values or element types).

• Error messages after Validation
In the lower window section, Project validation - Errors error messages are shown based on the valida-
tion, for example:

- Info (tab name): Description

- Error (tab name): Error description

For further information, see 4.9 Shared Functions.

• Current error messages

For every element that is marked with a warning symbol,  a quick info (tooltip) can be shown. Point to 
the element with the cursor. The quick info contains the element type and a description of the error that 
has appeared.

For further information, see 4.9 Shared Functions.
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4.2 Menu
4.2 Menu
.

Each menu consists of the following parts:

Menu Group Project

Within the menu group Project, you can call up the following functions:

• Project > New...
Creates a new project.

• Project > Open...
Open an existing project.

You can open only one project at a time. If you want to open another project or want to create a new one, 
you must close the Engineer.

• Project > Save
Save changes to an existing project.

• Project > Validate
Tests a project for validation and shows information or any errors in the window section Project validation 
Errors.

• Project > Print...
Prints all data of a project on your printer (also in PDF format).

• Project > Activate
Activates a project that has been edited, check for validation, and saved object for the runtime process.

• Project > Exit
Close the open project.

If the project has not been saved yet, a security question is asked whether it should be saved prior to clos-
ing.

Menu Group Edit

Within the menu group Edit, you can call up the following functions, which are also implemented in the toolbar:

• Edit > Undo
Reverses an executed function.

• Edit > Redo
Restores a reversed function.

 NOTE

You can reverse up to 500 changes.

 

Menu Group Help

Within the menu group Help, you can call up the following functions:

• Help > Engineer...
Calls up the help function of SIGUARD PDP UI and SIGUARD PDP Engineer

• Help > About...
Gives information about the program version of SIGUARD PDP Engineer
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4.3 Toolbar
4.3 Toolbar

Buttons

Executes the following functions via the buttons on the toolbar:

Table 4-1 Toolbar of SIGUARD PDP Engineer

Element Explanation
Click the button New, in order to create a new project.

Click the button Open, in order to open an existing project.

Click the button Save, in order to save changes to an existing project.

Click the button Validate, in order to check the opened project for valida-
tion.

Click the button Undo, in order to reverse an executed function.

Click the button Redo, in order to restore a reversed function.

Click the button Print in order to print all data from a project.

Click the button Activate, in order to activate a project that has been 
edited, tested for validation, and saved for the runtime process.
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4.4 Phasor Measurement Unit (PMU)
.

The following prerequisites must be fulfilled to parametrize a PMU:

• An existing project or a new project must be open.

• The tab PMU must be selected.

Tab PMU Is Selected

When you have selected the tab PMU, the layout for adding and editing physical and logical PMUs is shown.

Figure 4-2 Selected Tab PMU

• Available PMUs
In the left window section, the overview of all available PMUs in the directory All PMUs is shown.

• Selected PMU details
In the middle window section, the parameter data of the selected PMU is shown. If no PMU is created or 
selected this window section is colored gray.

In the upper part the parameters of the selected PMU are shown, and in the lower part the measuring 
points created for this PMU are shown in a table.
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4.4 Phasor Measurement Unit (PMU)
Functions

The following functions can be performed when the tab PMU is selected:

Table 4-2 Functions for PMUs

Parameters of a Physical PMU

When you have selected a physical PMU in the window section Available PMUs, the following right window 
section is displayed.

Figure 4-3 Parameters of a Physical PMU

In the following table, the setting options of the properties/parameters of a physical PMU are explained.

Table 4-3 Parameters of a Physical PMU

Element Explanation
Click the button New, in order to create a new, physical PMU in the 
marked directory All PMUs or a logical PMU within a marked physical 
PMU.
Click the button Duplicate, in order to duplicate either a marked, physical 
PMU with the same name and subordinated logical PMUs or a marked 
logical PMU.
Click the button Delete, in order to delete either a marked logical PMU or 
a marked physical PMU with all subordinated, logical PMUs.

Element Explanation
PMU device name The name of the physical PMU can be selected freely,

for example: Munich
Note
Ensure that all names in the overall system are unique, so that messages 
in the event and alarm list can be assigned uniquely. The uniqueness is 
checked in the framework of the validation.

PMU device ID ID of the connected, physical PMU
The data must be inherited from the configuration of the physical PMU.
for example: 30

IP address IP address of the connected, physical PMU
The data must be inherited from the configuration of the physical PMU,
for example: 192.168.0.109

Port Port to which the physical PMU is connected.
The data must be inherited from the configuration of the physical PMU,
for example: 4712
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4.4 Phasor Measurement Unit (PMU)
Further information can be found in the bibliography under /1/.

 NOTE

In case of missing or erroneous entry, the entry field is highlighted in red.

 

Parameters of a Logical PMU

When you have selected a logical PMU in the window section Available PMUs, the following right window 
section is displayed.

Figure 4-4 Parameters of a Logical PMU

In the following table, the setting options of the properties/parameters of a logical PMU are explained.

Table 4-4 Parameters of a Logical PMU

Reporting rate Number of telegrams (frames) per second that are transferred from the 
physical PMU.
The data must be inherited from the configuration of the physical PMU.
You can set the value via a list box from 10 frames/second up to 60 
frames/second.
If the value does not agree with the configuration of the physical PMU, an 
error message appears and no transfer takes place.

Timeout Time in secs how long a delayed telegram from the PMU was waited for.
Communication type You can select the type of communication tcp or udp via a list box.
UDP port Display only in case of selected type of communication udp,

for example: 4713

Element Explanation

Element Explanation
Logical PMU name The name of the logical PMU can be selected freely,

for example: Munich DAU1
Note
Ensure that all names in the overall system are unique, so that messages 
in the event and alarm list can be assigned uniquely. The uniqueness is 
checked in the framework of the validation.

Logical PMU ID ID of the connected, logical PMU.
The data must be inherited from the configuration of the physical PMU,
for example: 31
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 NOTE

The remaining parameter fields are not active (colored gray).

 

Editing Measuring Points
• Add measuring points

In order to add a measuring point, click in the last line of the column Name. Enter a name for the new 
measuring point. An additional blank line is inserted, by which a further measuring point can be defined.

The name PMU device of the physical PMU and the Logical PMU ID are automatically entered. The pa-
rameters Index, Type, and Unit make an entry according to the configuration of the physical PMU. Add 
further parameters.

• Copying/inserting measuring points
To copy measuring points, select one or several measuring points (lines) in the table and select the context 
menu Copy.

To insert copied measuring points, select the line at which it should be inserted and select the context 
menu Paste. As many lines, including the marked line, are always overwritten, as lines are inserted.

• Column sequence
You can move individual columns by dragging the heading to another place in the table, and thereby 
change the column sequence.

• Delete measuring points
To delete measuring points, select one or several measuring points (lines) in the table and press <Del>.

 NOTE

Ensure that you create precisely those measuring points that the PMUs to be connected actually use in later 
operation. A comparison with the parameter data of the PMUs is recommended.
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4.4 Phasor Measurement Unit (PMU)
Parameters of a Measuring Point

For every logical PMU the created measuring points are displayed in window section under the PMU parame-
ters in the form of a table. They can be edited only with a selected logical PMU.

Figure 4-5 Parameters of the Measuring Points

In the following table, the setting options of the properties/parameters of the measuring points are explained.

Table 4-5 Parameters of the Measuring Points

Element Explanation
Name The name of a measuring point can be selected freely,

for example: MchP/400/NbgH/U1
PMU device name Name of the physical PMU

The data are automatically inherited,
for example: Munich

Log PMU ID ID of the logical PMU
The data are automatically inherited,
for example: 31

Index The index is a pointer to the protocol transferred from the PMU, in order 
to identify the corresponding measurement.
The data must be inherited from the configuration of the physical PMU,
for example: 7

Type The measurement type can be entered via a list box.
Available types are: Phasor, Analog, or Digital.
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Saving a Project

The data of a project should be saved after every change or reconfiguration. You can even save a project when 
the validation is still not successful.

 NOTE

After saving a project, newly created measuring points are entered into the list Available measurements; 
deleted measuring points are also deleted from this list.

 

For further information on saving a project, see 4.9 Shared Functions.

Validation

Current errors can be displayed in tooltips during entry. A complete validation takes place via the menu Project 

> Validate or via the icon . If error messages are displayed, re-edit the configuration. If the validation is 
free of errors, the project can be activated for the runtime process.

For further information on validating a project, see 4.9 Shared Functions.

Activation of a Project

After successful validation, an opened and saved project can be made available to the runtime process. This 

takes place via the menu Project > Activate or via the icon .

For further information on activating a project, see 4.9 Shared Functions.

Unit The unit of the measured value that is measured at this measuring point 
can be entered according to measurement type via a list box,
for example: A for current, V for voltage, W for active power, VA for ap-
parent power, VAr for reactive power, Degree for the phase angle, Hz for 
frequency, or Hz/s for the frequency changing speed.

Archive If the check box is marked, the measured values at this measuring point 
are saved in the archive.

Nominal Entry of the rated value of the value to be measured,
for example: 400000
If the check box is selected, the rated value is included in the measure-
ment.

Min1 ... Min3 Definition of up to 3 lower limiting values regarding the rated value,
for example: 380000, 360000 and 340000.

Max1 ... Max3 Definition of up to 3 upper limiting values regarding the rated value,
for example: 420000, 430000 and 440000.
If the respective check box is marked, the corresponding limiting value is 
included in the measurement.

Factor PSS The PSS factor states the influence of the measurement on the PSS 
curve.
The higher the PSS factor selected, the greater the influence on the PSS 
curve.
Standard = 1

Element Explanation
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4.5 Calculated Measurements
4.5 Calculated Measurements
.

The following requirements must be satisfied for creating and editing calculated values:

• A project must be created or an existing project must be opened.

• The tab Calculation must be selected.

The Calculation Tab Is Selected

When you have selected the tab Calculation, the layout for adding and editing calculated values is displayed.

Figure 4-6 Selected Tab Calculation

• Calculated measurements
In the left window section, the overview of all existing calculated values are shown in the directory All cal-
culated objects.

• Selected calculated measurements
In the middle window section, the parameter data (Name, Factor, and Formula) of a selected calculated 
value is displayed.

• Available measurements
In the right window section, all available values Available measurements are displayed with name, type, 
and unit, which are used for the input measurand of the formula.
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4.5 Calculated Measurements
Functions

The following functions can be executed via buttons in the tree view when the tab Calculation and marked 
element are selected.

Table 4-6 Functions for Calculated Values

Parameters of a Calculated Value

When you have selected a calculated value in the window section Calculated measurements, the following 
middle window section is displayed.

Figure 4-7 Parameters of a Calculated Value

A calculated value consists of the Name, which is made up of the Factor and the Formula.

In the following table, the setting options of the properties/parameters of the calculated values are explained.

Element Explanation
Click the button Create a new calculation, in order to create a new, cal-
culated value in the marked directory All calculated objects.
Click the button Duplicate a selected calculation, in order to duplicate 
a marked, calculated value for further editing.
Click the button Delete the selected calculation or press the key 
Delete, in order to delete a marked, calculated value.
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4.5 Calculated Measurements
Table 4-7 Parameters of a Calculated Value

 NOTE

Empty entry fields are highlighted in red. Enter a value.

 

Defining Calculated Values

If a newly created calculated value is not yet defined, for example, if no formula is stored, the list box is unde-
fined.

Define a formula with the corresponding input measurands. The type of the calculated value is determined from 
the first input measurand (phasor, analog, or digital), and furnished with the corresponding unit in the overview, 
if the formula allows variable input measurands. Other formulas require input measurands of a precisely 
defined type.

Defining Formulas

The following formula functions are available.

Table 4-8 Overview of the Formulas for a Calculated Value

Element Explanation
Name In this field, the name of the calculated value is entered, changed, or dis-

played in the case of an existing value. The name can be selected freely.
If no entry takes place a name is automatically assigned.

Factor Multipliers for calculated values
Only numerical entries with a period in the place of the comma are valid.

Formula You can select various formula functions. For this, corresponding input 
measurand Input measurements are necessary, which can be defined 
via measured and calculated values.

Save results to archive If the check box is marked, its value is saved in the archive.
Saving is not necessarily required, since the value can also be recreated 
based on the input measurand.
However, you must expect a longer retrieval time, since greater amounts 
of data must be retrieved from the archive.

Input measurements Input measurand for the calculation that is assumed from the measured 
and calculated values Available measurements.
For certain formulas, it is also possible to enter constants.

Element Formula Explanation
Active power (6 inputs) P = Re{V1*conj(I1)} + 

Re{V2*conj(I2)} + Re{V3*conj(I3)}
Calculation of the active power with 
6 input measurands

Active power (substation usage) P = Re{(bb1*V1 + bb2*V2 + 
bb3*V3) *conj(I)}

Calculation of the active power, 
based on the busbar voltages (V1 to 
V3) and the current in the bay (i) 
while considering the position of the 
busbar disconnector (bb1 to bb3)

Active power (2 inputs) P = Re{V*conj(I)} Calculation of the active power with 
2 input measurands

Add 2 analogs x = a + b Addition of 2 analog values
Add 2 phasors X = A + B Addition of 2 phasors (2 voltages or 

2 currents, respectively)
Angle difference between 2 
phasors

x = deg(A) - deg(B) Calculation of the phase angle 
between 2 phasors
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4.5 Calculated Measurements
Apparent power (6 inputs) S = IV1*conj(I1)I + IV2*conj(I2)I + 
IV3*conj(I3)I

Calculation of apparent power with 
6 input measurands

Apparent power (substation usage) S = I(bb1*V1 + bb2*V2 + bb3*V3) 
*conj(I)I

Calculation of the apparent power, 
based on the busbar voltages (V1 to 
V3) and the current in the bay (i) 
while considering the position of the 
busbar disconnector (bb1 to bb3)

Apparent power (2 inputs) S = IV*conj(I)I Calculation of apparent power with 
2 input measurands

Conductance from V and I G = Re{[(V1*I1 - V2*I2) + (V1*I2 - 
V2*I1)] / (V2**2 - V1**2)}

Conductance G of a line through 
measurement of the voltage and 
current at the beginning and the end

Conjugate a phasor X = conj(A) Conjugation of a phasor (voltage or 
current)

Divide 2 analogs x = a/b Division of 2 analog values (num-
bers)

Logical AND x = AND(a,b) Logical AND relation of 2 digital 
inputs

Logical NOT x = NOT(a) Logical inversion of a digital input
Logical OR x = OR(a,b) Logical OR operation of 2 digital 

inputs
Logical XOR x = XOR(a,b) Logical XOR operation of 2 digital 

inputs
Multiply 2 analogs X = a*b Multiplication of 2 analog values 

(numbers)
Negative sequence Xneg = (A + a**2*B + a*C)/3 Calculation of system components 

negative-sequence system
Positive sequence Xpos = (A + a*B + a**2*C)/3 Calculation of system components 

positive-sequence system
Power factor lambda = P/S = Re{V*conj(I)} / 

IV*conj(I)I
Calculation of the power factor from 
active power and apparent power 
and the input measurands voltage 
and current

Reactance from V and I X = Im{1/Yq} = Im{V1**2 - V2**2) / 
(V1*I2 - V2*I1)}

Reactance X of a line through 
voltage and current measurement 
at the beginning and the end

Reactive power (6 inputs) Q = Im{V1*conj(I1)} + 
Im{V2*conj(I2)} + Im{V3*conj(I3)}

Calculation of reactive power with 6 
input measurands

Reactive power (substation usage) Q = Im{(bb1*V1 + bb2*V2 + 
bb3*V3) *conj(I)}

Calculation of the apparent power, 
based on the busbar voltages (V1 to 
V3) and the current in the bay (i) 
while considering the position of the 
busbar disconnector (bb1 to bb3)

Reactive power (2 inputs) Q = Im{V*conj(I)} Calculation of reactive power with 2 
input measurands

Resistance from V and I R = Re{1/Yq} = Re{(V1**2 - V2**2) / 
(V1*I2 - V2*I1)}

Resistance R of a line through mea-
surement of the voltage and current 
at the beginning and the end

Rotate a phasor X = A * Power(e,x) Rotation of a phasor
Scaling of analog x = m * a + c Scaling of an analog value a with 

the help of a gradient m and a con-
stant summand c

Element Formula Explanation
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4.5 Calculated Measurements
Allocate Input Quantities

Depending on the formula, a corresponding number of entry fields for the input measurands Input measure-
ments are represented. Before each field, the type/unit of the measured or calculated value Available mea-
surements is displayed, which must be routed to this field.

Example:

If, for example, a phasor is supposed to be multiplied by an analog value, then a phasor must be routed as the 
first input measurand. Only an analog value can be routed to the second input measurand. Other routings are 
not valid and cannot be executed.

Assuming Formulas

In case of duplicated calculated values, there are 2 possibilities for defining formulas and corresponding input 
measurands:

• Selection of a formula via the list box and reallocation of the input measurands from the measured and 
calculated values Available measurements

• Select the contents of the list box by double-clicking. This activates the group function and the selection 
of the formula can be performed via the keys <Arrow up> or <Arrow down>, where already existing input 
measurands are maintained and do not need to be rerouted.

 NOTE

The old input measurands are only assumed if the list box is opened up and a function is selected with the same 
input types.

 

Saving a Project

The data of a project should be saved after every change or reconfiguration. You can even save a project when 
the validation is still not successful.

For further information on saving a project, see 4.9 Shared Functions.

Validation

Current errors can be displayed in tooltips during entry. A complete validation takes place via the menu Project 

> Validate or via the icon . If error messages are displayed, re-edit the configuration. If the validation is 
free of errors, the project can be activated for the runtime process.

For further information on validating a project, see 4.9 Shared Functions.

Subtract 2 analogs x = a - b Subtraction of 2 analog values 
(numbers)

Subtract 2 phasors X = A - B Subtraction of 2 phasors (2 voltages 
or 2 currents, respectively)

Susceptance from V and I B = Im{[(V1*I1 - V2*I2) + (V1*I2 - 
V2*I1)] / [V2**2 - V1**2)}

Susceptance B of a line through 
measurement of the voltage and 
current at the beginning and the end

Zero sequence Xzero = (A + B + C)/3 Calculation of system components 
zero-sequence system

Element Formula Explanation
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4.5 Calculated Measurements
Activation of a Project

After successful validation, an opened and saved project can be made available to the runtime process. This 

takes place via the menu Project > Activate or via the icon .

For further information on activating a project, see 4.9 Shared Functions.
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4.6 Graphical Representation of Power-Supply Systems (Graphics)

4.6.1 Overview
.

The following requirements must be met in order to create and edit graphical displays of networks:

• A project must be created or an existing project must be opened.

• The tab Graphics must be selected.

The Graphics Tab Is Selected

If the tab Graphics was selected, the layout for creating network graphics is displayed.

Figure 4-8 Selected Tab Graphics

• Elements
In the left window section, the overview of all elements already existing in the directory root are shown 
(for example, Layer1 for the complete graphic or parts of a graphic and subelements for stations, lines, 
and others). The overview represents an organization of the graphical elements for a network.

• Graphics view
In the upper part of the middle window section, Google Earth is opened as a background. A network can 
be overlaid graphically over the map from the element types.
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• Element properties
In the lower part of the middle window section, the properties of the marked element are displayed.

The properties are divided into:

- General properties, tab Properties

- Properties of the coordinates, tab Coordinates

- Setting for the camera, tab Camera

- List of routed measurements, tab Measurements

• Element types
A library of graphical elements is shown in the upper part of the right window section. These elements are 
available for drawing a graphical network structure in the window section Graphics view.

• Available measurements
In the lower part of the right window section, all available measurements Available measurements are 
shown with name, type, and unit, which are drawn on for the configuration of the element properties and 
produce a color according to the quality of the measured value.

Functions for Elements

The following functions can be executed for editing the elements via buttons.

Table 4-9 Functions for Elements

Element Explanation
Click the button New, in order to create a new graphic New layer in the 
directory root or an element in the marked graphics folder.
Click the button Duplicate, in order to duplicate an existing graphic or an 
existing graphic element. The graphic or the graphic element is inserted 
at the end of the respective group.
Click the button Delete, in order to delete a graphic or graphic element.

Click the button KML, in order to import coordinates for a graphic 
element in KML format.
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Functions for Graphical Editing

The representation of a network on the map is comparable to a structure with 2 levels that lie on top of one 
another:

• Google Earth level

Representation of the map with the corresponding Google Earth functions

• User level

Representation of a network with the parameters that are defined in SIGUARD PDP Engineer in the tab 
Graphics.

The following functions can be performed for graphical processing of the elements in the window section 
Graphics view via buttons.

Figure 4-9 Interface for the Editing of Graphic Elements
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Table 4-10 Functions for Graphic Elements

Element Explanation

Google Earth level

Click the button Navigate in map, to navigate within the map and use the 
functions of Google Earth.

User level

Click the button Drag mode, in order to define, or change the position of 
an element.
• Positioning Element

- Click the button Drag mode.
- Select a layer in the tree structure under which the new element 

should be created.
- Select an element in the window Element types.
- Use drag and drop to pull the element to the desired position in 

Graphics view.
The newly positioned element appears in the tree structure. For 
this, the properties under Properties can now be defined.

• Changing Element Position
- Click the button Drag mode.
- Select the element in the tree structure.
- Use drag and drop to pull the selected element to the new position 

in Graphics view.
The graphical icon changes its position.

User level

Click the button Zoom to area, in order to select a rectangle, the contents 
of which are enlarged to the size of the window section.

Google Earth level

Click the button Zoom in, in order to gradually enlarge the map.

Google Earth level

Click the button Zoom out, in order to gradually scale down the map.
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4.6.2 Properties of the Elements
.

The parameter assignment of the properties of an element is distributed to the following tabs.

Properties

On the tab Properties, the following parameters are available.

Figure 4-10 Parameter Properties

Table 4-11 Parameters of the Tab Properties

Coordinates

On the tab Coordinates, the following functions are available.

Figure 4-11 Parameter Coordinates

Element Explanation
Internal Name Name of the element that is displayed in the overview (technical name)
Displayed Name of the element that is displayed in the map (for example, Berlin)
Description Description of the element
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Table 4-12 Functions of the Tab Coordinates

Element Explanation
Click the button Add Coordinate and into the map, in order to add a new 
coordinate for this element. The new coordinate is inserted under the 
marked line.
The parameters of a coordinate are shown in a table. Editing is not pos-
sible here.
• Longitude

Parameter for the geographical length in degrees (length in degrees).
• Latitude

Parameter for the geographical width in degrees (width in degrees).
• Height

Parameter for elevation over NN.
Click the button Change Coordinate, in order to change the position of 
an element.
• Select the element in the tree structure, the position of which is to be 

changed.
• Click the button Change Coordinate.

The cursor appears as + - icon in Graphics view
• Position the cursor on the new position and double-click the left mouse 

button.
The new coordinates are assumed in the table.

Click the button Fly to coordinate, in order to transfer a saved camera 
position to a new element and in order to fly to individual coordinates with 
the saved camera position.
• Double-click the element in the tree structure, the camera position of 

which (angle of view and elevation) is to be assumed.
The selected camera position is displayed in Graphics view.

• Click the element in the tree structure for which the camera position 
(angle of view and elevation) is to be assumed.
The previous coordinates are displayed.

• Click the button Fly to coordinate.
The camera position (field of vision and elevation) is transferred to the 
new element and displayed in Graphics view.

The individual coordinates (for example, of a line) can now be selected 
and the corresponding camera position displayed:
• Select the coordinates and click the button Fly to coordinate.
• Double-click a coordinate (line).

The camera position (field of vision and elevation) of the selected coor-
dinates is displayed in Graphics view.
During the start of the line, the camera elevation can be adapted via the 
Google function. The next operation of the button Fly to Coordinate will 
remember this.
Click the button Remove Coordinate, in order to delete a marked coor-
dinate for this element.
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Camera

The camera position is the way of viewing an element in Google Earth. The setting occurs via a double-click 
on the element and scrolling in horizontal or vertical direction.

On the tab Camera, the following functions for the configuration of the camera position of an element are avail-
able.

Figure 4-12 Settings for the Camera Position

Table 4-13 Functions of the Tab Camera

Measurements

On the tab Measurements, the measuring points are displayed which were defined for this element. In this way, 
a linkage of the graphic element to the measuring channels is created.

Figure 4-13 Parameter Measurements

Element Explanation
Click the button Set, in order to save the set camera position for an ele-
ment.
To display this camera position in Graphics view again, double-click the 
element in the tree structure.
Click the button Clear, in order to delete the set camera position for an 
element.
SIGUARD PDP Phasor Data Processing, Manual
E50417-H1076-C419-A3, Release 11.2011

111

http://siemens-russia.com/


SIGUARD PDP Engineer
4.6 Graphical Representation of Power-Supply Systems (Graphics)
Table 4-14 Functions of the Tab Measurements

In order to delete measuring points, select a measuring point (line) and click the corresponding button .

4.6.3 Element Types
.

In the upper right window section, Element types of the tab Graphics various types of elements are available 
to you for the creation of a graphical network structure.

Figure 4-14 Overview of the Element Types

Table 4-15 Functions of the Tab Measurements

Element Explanation
MeasurementName Allocation of measuring points

The measuring points are assumed from Available measurements into 
the column MeasurementName and thus are defined for this graphic el-
ement. The quality of the measured values is responsible for the coloring 
of the elements in SIGUARD PDP UI. The measuring points cannot be 
edited here.

MeasurementType Type of measuring point (for example, phasor, analog, or digital mea-
sured value and, calculated analog or digital measured value).

Element Explanation
Layer Folder for graphic elements
Substation Element for a Station
PMU Element for a Phasor Measuring Unit (PMU)
Generator Element for a current generator
Compensator Element for a Static Var Compensator SVC
Line (5 pixel) Element for a thick line (collective representation of parallel systems)
Line (3 pixel) Element for a thin line (individual line)
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Saving a Project

The data of a project should be saved after every change or reconfiguration. You can even save a project when 
the validation is still not successful.

For further information on saving a project, see 4.9 Shared Functions.

Validation

Current errors can be displayed in tooltips during entry. A complete validation takes place via the menu Project 

> Validate or via the icon . If error messages are displayed, re-edit the configuration. If the validation is 
free of errors, the project can be activated for the runtime process.

For further information on validating a project, see 4.9 Shared Functions.

Activation of a Project

After successful validation, an opened and saved project can be made available to the runtime process. This 

takes place via the menu Project > Activate or via the icon .

For further information on activating a project, see 4.9 Shared Functions.
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4.7 Applications

4.7.1 Overview
.

For configuring and assigning parameters of applications, the following requirements must be met:

• An existing project or a new project must be open.

• The tab Application must be selected.

The Application Tab Is Selected

When you have selected the tab Application, the layout for adding and editing applications is displayed.

Figure 4-15 Selected Tab Application

• Existing Applications
In the left window section, all available communication interfaces are displayed as folders:

- Island detections (ISDs)

- Power swing recognitions (PSRs)

- Voltage stability curves (VSCs)

• Selected Application
In the middle window section, the parameter data of the selected application is shown.
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• Available measurements
In the right window section, all available values Available measurements are displayed with name, type, 
and unit, which are used for the input measurands of the configuration of the applications.

4.7.2 Island State Detection (ISD)
.

To configure island detection, the folder ISDs is selected and a name for the folder ISDs is defined:

Figure 4-16 Name for ISDs folder is assigned

Next, the folder ISDs is opened and island detection is selected.

 NOTE

You need a corresponding SIGUARD PDP license for the ISD to function. The existence of this license is not 
queried in the SIGUARD PDP Engineer.
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4.7 Applications
Functions

For a selected folder ISDs or selected island detection, the following functions can be performed via buttons. 

Table 4-16 Toolbar of the ISDs application

Parameters of an Application ISDs

If the folder ISDs is opened and an island detection is selected, the following middle window section Applica-
tion - Island detection is displayed:

Figure 4-17 Parameters of the Application ISDs

Element Explanation
Click the button New island detection in order to create a configuration 
scheme for a new application Island detection in the ISDs folder.
Click the button Duplicate island detection to duplicate a configuration 
of an existing application Island detection for further processing.
Click the button Delete island detection in order to delete an application 
Power swing recognition.
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In the following table, the setting options of the properties/parameters of the application ISDs are explained.

Table 4-17 Parameters of the Application ISDs

Element Explanation
Name In this field the name of the application Island detection is entered, 

changed, or displayed for an existing application.
Active If the check box is marked, the application is switched to active.
Time constant Time constant for static (Default = 1) and dynamic island detection (De-

fault = 0.2) in seconds
Limit for Network Split Upper limiting value in Hz for static island detection

If the frequency difference between at least 2 neighboring frequencies is 
larger than the upper limiting value (Standard = 0.05 Hz), an island is de-
tected.

Limit for Potential Network Split 
(static island detection)

Upper limiting value in Hz for static island detection
If the frequency difference between at least 2 neighboring frequencies is 
smaller than the lower limiting value (Standard = 0.01 Hz), no island is 
detected. 
If the frequency difference between at least 2 neighboring frequencies 
lies between the lower and upper limiting values, there is a possible 
network split.
If the check box is marked, a message is triggered in the case of an ex-
ceedance of the limiting value.

Limit for Potential Network Split (dy-
namic island detection)

Upper limiting value in Hz for dynamic island detection
If the difference between at least 2 neighboring values for the rate of fre-
quency change is larger than the limiting value (Standard = 0.001 Hz/s), 
there is a possible network split (island detection). 
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Configuration of Sites

A site is the aggregation of measuring points of a PMU.

It consists of the measuring points for a frequency (f) and a frequency changing speed (df/dt). In order to be 
able to compare frequency changing speeds, at least 2 sites per application Island detection must therefore 
be created and switched to active.

Figure 4-18 Configuration of Sites for Island Detection

 NOTE

Empty entry fields are highlighted in red. The measuring points must be inserted here via drag and drop.

 

In the following table, the setting options of the properties/parameters of the Sites are explained.

Table 4-18 Parameters of the Sites

Element Explanation
Site Numbering occurs automatically.
f Sort the list Available measurements according to type.

Insert a measuring point for the frequency (f) from Available measure-
ments.
It is checked whether a measuring point for the frequency is also insert-
ed. The measuring point can come from different PMUs.
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4.7.3 Power Swing Recognition PSRs
.

To configure power swing recognition, the folder PSRs is selected and a name for the folder PSRs is assigned:

Figure 4-19 Name for PSRs Folder is Assigned

Next, the folder PSRs is opened and a swing recognition is selected.

 NOTE

You need a corresponding SIGUARD PDP license for the PSR to function. The existence of this license is not 
queried in the SIGUARD PDP Engineer.

 

df/dt Sort the list Available measurements according to type.
Insert a measuring point for the rate of frequency change (df/dt) from 
Available measurements.
It is checked whether a measuring point for the frequency changing 
speed is also inserted. The measuring point can come from different 
PMUs.

Active If the check box is marked, the provision for the corresponding measur-
ing point for the evaluation of island detection occurs.

Element Explanation
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4.7 Applications
Functions

For a selected folder PSRs or selected power swing recognition, the following functions can be performed via 
buttons. 

Table 4-19 Toolbar of the PSRs Application

Parameters of application PSRs

If the folder PSRs is opened and you have opened a new power swing recognition, the following middle window 
section Application Power Swing Recognition is displayed:

Figure 4-20 Parameters of the PSRs Application

Element Explanation
Click the button New power swing recognition to create a configuration 
scheme for a new application Island detection in the PSRs folder and a 
subordinate job.
Click the button Duplicate power swing recognition to duplicate a con-
figuration of an existing application Power swing recognition for further 
processing.
Click the button Delete Power Swing Recognition to delete a configu-
ration for an application Island detection.
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The setting options for the properties/parameters of the application PSRs are explained in the following table.

Table 4-20 Parameters of the PSRs Application

Parameters of a PSR Job

If you have selected PSR job, the following middle window section Application power swing recognition is 
displayed:

Figure 4-21 Parameters of the PSR Job

The setting options for the properties/parameters of a PSR job are explained in the following table.

Table 4-21 Parameters of a PSR Job

Element Explanation
PSR Name In this field, the name of the application Power swing recognition is en-

tered, changed, or displayed for an existing application.
Active If the check box is selected, the application is switched to active.
ISD If the check box is selected, the results of the application ISD (Island 

State Detection) are used by suppressing calculation of jobs whose input 
variables lie in 2 different islands.

Element Explanation
Job Name In this field, the name of the PSR job is entered, changed, or displayed 

for an existing PSR job.
Active If the check box is selected, the PSR job is switched to active.
ISD If the check box is selected, the processing of this job is set, if the ISD 

has recognized that the input values lie in different islands.
Only effective with jobs in Job mode Phase angle.
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Job mode PSR recognizes 2 different Job modes:
• Active Power.

Voltage and current are linked to one another at a PMU location. The 
active power calculated from that is analyzed for power swings.

• Phase angle.
The voltages are linked together at 2 different locations. The voltage 
angle difference calculated from this is analyzed for power swings.

Thresholds/Events, nominal This rated value is used as reference for the relative threshold values 
stated below for the warning or the alarm based on the magnitude. Also 
see Figure 1-10 in chapter 1.5 SIGUARD PDP Power Swing Recognition 
(PSR).

Threshold - Magnitude/Alarm If this relative value for the magnitude is exceeded, then this power swing 
is placed in the 1st row of the DOE table. Reference value is the rated 
value, see above. Also see Figure 1-10 in chapter 1.5 SIGUARD PDP 
Power Swing Recognition (PSR).

Threshold - Magnitude/Warning If this relative value for the magnitude is exceeded, then this power swing 
is placed in the 2nd row of the DOE table. Reference value is the rated 
value, see above. Also see Figure 1-10 in chapter 1.5 SIGUARD PDP 
Power Swing Recognition (PSR).

Threshold - Damping Ratio/Alarm If this value for the damping factor is exceeded, then this power swing is 
placed in the 3rd column of the DOE table. Note that this value must be 
negative. Also see Figure 1-10 in chapter 1.5 SIGUARD PDP Power 
Swing Recognition (PSR).

Threshold - Damping Ratio/Warn-
ing

If this value for the damping factor is exceeded, then this power swing is 
placed in the 2nd column of the DOE table. Note that this value must be 
negative. Also see Figure 1-10 in chapter 1.5 SIGUARD PDP Power 
Swing Recognition (PSR).

Element Explanation
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Input Parameters

After the general parameters for the PSR job were set, the Inputs (measured values for voltage and current) 
must be defined in the middle window section Application power swing recognition for each phase.

Figure 4-22 Input parameters for the phases

The setting options for the properties/parameters of the Inputs are explained in the following table.

Table 4-22 Parameters of the Input Variables

Element Explanation
Inputs L1 - L3 The following measuring points from the Available measurements list 

must be defined for each phase:
• One measuring point Voltage 1 and one measuring point Current for 

the job mode Active Power
• One measuring point Voltage 1 and Voltage 2 for the job mode Phase 

Angle

These values are pulled into the table via drag and drop from the Avail-
able measurements. Fields that must contain values are marked red.

Only one phase If the check box is selected, the phases 2 and 3 are hidden. Only one 
phase is active.
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Determine Modes for the Job

After the definition of the input variables, the Modes 1 must be defined in the middle window section Applica-
tion Power Swing Recognition.

For this, a mode name is defined. The appropriate outputs are created automatically.

Figure 4-23 Definition of the Mode Name/Outputs

The setting options for the properties/parameters of the application Modes are explained in the following table.

Table 4-23 Parameters of the Input Variables

1. Available power swings can also be composed of partial power swings with different frequencies. These partial power 
swings are also designated a power swing mode.

Element Explanation
Name If a name is entered for the mode, for example, Mode4, the correspond-

ing Outputs are created for this (entries for the types:
• Frequency
• Magnitude
• Damping ratio
• Degree of Exposure

Frequency band If the check box is selected, the fields for Maximum frequency and 
Minimum frequency are released for the maximum and minimum fre-
quencies.
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Selecting Modes

In order to maintain the overview with several modes, the entire row can be selected for a mode, for example, 
Mode2. In this case, only the outputs for Mode2 are displayed.

Figure 4-24 Selected Mode/Outputs

Table 4-24 Parameters of the Output Quantities

You can find further information on saving, activating, and validating the project in chapter 4.9 Shared Func-
tions.

Minimum frequency Minimum frequency
Power swings with a natural frequency larger than this minimum frequen-
cy and smaller than the maximum frequency Maxf are preferentially as-
signed to this mode.

Maximum frequency Maximum frequency
Power swings with a natural frequency larger than the minimum frequen-
cy Minf and smaller than this maximum frequency are preferentially as-
signed to this mode.

Element Explanation

Element Explanation
Mode If a name is selected for the mode, for example, Mode4, the correspond-

ing Outputs are displayed with the name of the mode.
Type Type of output quantities (for example, frequency, magnitude, damping)
Name Name of the output quantity
Archive Selection, so that the output quantities are saved in the archive.
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4.7.4 Voltage Stability Curve (VSC)
.

To configure the display of a voltage stability curve, the folder VSCs is selected and a name for the folder ICCP 
is defined:

Figure 4-25 Name for VSCs Folder is Assigned

Next, the folder VSCs is opened and a curve is selected.

Functions

For a selected folder VSCs or a selected voltage stability curve, the following functions can be performed via 
buttons. 

Table 4-25 Toolbar of the VSCs Application

Element Explanation
Click the button New voltage stability curve in order to create a config-
uration scheme for a new voltage stability curve in the VSCs folder.
Click the button Duplicate voltage stability curve to duplicate a config-
uration of an existing voltage stability curve for further processing.
Click the button Delete voltage stability curve to delete a configuration 
of an existing voltage stability curve.
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Parameters of an Application VSCs

The following configurations for the display of a voltage stability curve are possible:

• Configuration with input measurands and line parameter (1 PMU)

• Configuration with input measurands and output measurands (2 PMU)

If you open the folder VSCs in the window section Existing applications, a voltage stability curve is selected 
and the check box 1 PMU has been selected, the following middle window section Voltage stability curves is 
displayed:

Figure 4-26 Parameters of the Application VSCs with Input Measurands (1 PMU) and Line Parameter

 NOTE

Empty entry fields are highlighted in red. Enter a value.

 

In the following table, the setting options of the properties/parameters of the application VSCs are explained 
with input measurands.

Table 4-26 Parameters of the Application VSCs

Element Explanation
1 PMU This check box is selected when the voltage stability curve is supposed 

to be calculated with an input measurand and the line parameters.
Name In this field the name of the voltage stability curve is entered, changed, 

or displayed for an existing voltage stability curve.
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When you have selected the application VSCs in the window section Existing Applications and marked the 
check box 2 PMU, the following middle window section is displayed.

Figure 4-27 Parameters of the Application VSCs with Input and Output Measurands (2 PMU)

 NOTE

Empty entry fields are highlighted in red. An entry is required.

 

Pmax Entry of the maximum active power for the observed line in megawatts 
(MW).

Vmax Entry of the maximum voltage for the observed line in kilovolts (kV).
Vin Measurand of the voltage at the input of the line from Available mea-

surements
Iin Measurand of the current at the input of the line from Available mea-

surements
R Resistance of the line in ohms
X Reactance of the line in ohms
G Conductance of the line in micro-siemens
B Susceptance of the line in micro-siemens

Element Explanation
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In the following table, the setting options of the properties/parameters of the application VSCs are explained 
with input and output measurands.

Table 4-27 Parameters of the Application VSCs

Element Explanation
2 PMU This check box is selected when the voltage stability curve is supposed 

to be calculated with an input and output measurand.
Name In this field the name of the voltage stability curve is entered, changed, 

or displayed for an existing voltage stability curve.
Pmax Entry of the maximum active power for the observed line in megawatts 

(MW).
Vmax Entry of the maximum voltage for the observed line in kilovolts (kV).
Vin Measurand of the voltage at the input of the line from Available mea-

surements
Iin Measurand of the current at the input of the line from Available mea-

surements
Vout Measurand of the voltage at the output of the line from Available mea-

surements
Iout Measurand of the current at the output of the line from Available mea-

surements
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4.8 Communication

4.8.1 Overview
.

To configure and set the communication interface parameters, the following requirements must be met:

• An existing project or a new project must be open.

• The tab Communication must be selected.

The Communication Tab Is Selected

When you have selected the tab Communication, the layout for adding and editing communication interfaces 
is displayed.

Figure 4-28 Selected Tab Communicated

• Available communication interfaces
In the left window section, all available communication interfaces are displayed as folders:

- C37.118

- ICCP

- OPC

• Selected Application
In the middle window section, the parameter data for the selected communication interfaces are shown.
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• Available measurements
In the right window section, all available values Available measurements are displayed with name, type, 
and unit, which are used for the input measurands within the configuration of the applications.

4.8.2 Protocol C37.118
.

The function of the PDC server is the following: 

SIGUARD PDC sends data in the IEEE C37.118 protocol to other PDCs. In this way, the data from SIGUARD 
PDP can also be used by other PDCs.

To configure the communication interfaces, the folder C37118 is selected, and a name for the folder C37118 is 
assigned.

Figure 4-29 Name for Folder C37118

Next, the C37118 folder is opened and an interface is selected.
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Functions

The following functions can be performed when the folder C37118 is selected:

Table 4-28 Functions for PDC Servers and Logical PMUs

Parameters of the PDC Server

When you have selected a PDC server in the window section PDCServers and logical PMUs, the following 
middle window section is displayed.

Figure 4-30 Parameters of the PDC Server

Element Explanation
Click the button New, in order to create a new PDC server.
or
in the case of a selected PDC server to set up a subordinate logical PMU.
Click the button Duplicate, in order to create a duplicate with the same 
name and subordinate logical PMUs for the selected PDC server.
or
to duplicate a selected logical PMU.
Click the button Del, in order to delete a selected PDC server with the 
subordinate logical PMUs
or
to delete a selected logical PMU.
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In the following table, the setting options of the properties/parameters of a PDC server are explained.

Table 4-29 Parameters of the PDC Server

 NOTE

In case of missing entry, the entry field is highlighted in red. Enter a value.

 

Element Explanation
PDC server name You can freely select the name of the PDC server. This name is entered 

as PDC Server Name in the protocol IEEE C37.118 and is agreed with 
the communication partner. It does not need to be unique (see Internal 
name),
for example: SIGUARD.

PDC server ID ID of the connected PDC server
This name is entered as PDCID in the protocol IEEE C37.118 and is 
agreed with the communication partner,
for example: 111.

Local IP address IP address at which the PDC server can be reached from the outside. 
This IP address helps to define the LAN interface to be used for commu-
nication to the outside. If there is only one interface, then enter the IP 
address of the server, for example, 55.26.213.186.

Local port Port number at which the PDC server can be reached from the outside,
for example: 4712.

Remote IP address IP address of the outside PDC servers (a client from the perspective of 
the SIGUARD PDC server).
Only one PDC server with this IP address can establish a connection with 
the local SIGUARD PDC server.

Internal name This name must be unique and may not occur in the case of other objects 
(for example, measured value, calculation, etc.).

Reporting rate Number of telegrams that can be transferred per second by the PDC 
server.
The Reporting rate must be agreed with the communication partner.
CAUTION 
Note that not all combinations are possible. Which value in allowed 
depends on the Reporting rate of the values to be transferred.
You can set the value via a list box from 10 up to 60 frames/second.
If the value does not agree with the configuration of the PDC server, an 
error message appears and no transfer takes place.

Communication type Via a list box the communication type tcp or udp can be selected.
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Parameters of a Logical PMU

When you have selected a logical PMU in the window section PDC servers and logical PMUs, the following 
middle window section is displayed.

Figure 4-31 Parameters of a Logical PMU and the Measuring Channels

In the following table, the setting options of the properties/parameters of a logical PMU are explained.

Table 4-30 Parameters of a Logical PMU

 NOTE

The remaining parameter fields are not active (colored gray), because they are not parameterizable here.

 

Element Explanation
Station name You can freely select the name of a logical PMU. This name is entered 

as PDC Station Name in the protocol IEEE C37.118 and is agreed with 
the communication partner. It does not need to be unique (in contrast to 
Internal name),
for example: SIGUARD PMU1.

Logical PMU ID ID of the connected, logical PMU
This ID is entered as PMUID in the protocol IEEE C37.118 and is agreed 
with the communication partner, 
for example: 112.

Rated frequency Rated frequency of the station, 
for example: 50 Hz.
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Editing Measuring Channels
• Add measuring channel

In order to add a measuring channel, add a measuring point from Available measurements in the last 
line of the column Measurement. An additional blank line is inserted, by which a further measuring 
channel can be defined.

• Delete measuring channel
To delete measuring channels, select the measuring channel (line) in the table and press the key <Del> 
or select the context menu delete.

• Sorting according to column contents
The list of measuring channels can be sorted according to the contents of the columns. Clicking the 
header sorts in ascending or descending list items.

• Column sequence
You can move individual columns by dragging the header to another place in the table, and thereby 
change the column sequence.

• Change column widths
All columns can be changed widthwise by dragging the column edge.

Parameters of a Measuring Channel

For every PMU server the measuring channels set up for this is displayed in the form of a table in the middle 
window section under the parameters of the PMU server and the selected logical PMU.

In the following table, the setting options of the properties/parameters of the measuring channels are explained.

Table 4-31 Parameters of a Measuring Channel

Element Explanation
Channel name You can freely select the name of the measuring channel. Since it is 

entered into the protocol IEEE C37.118, the Channel name may not 
exceed a length of 16 characters, 
for example: MchP/400/NbgH/U1.

Measurement Definition of the measuring point from Available measurements. The 
values measured here are transferred via this measuring channel.

Meas. Mode Definition of the method of measurement for analog values except fre-
quency and rate of frequency change
The following parameters are displayed on the basis of the measuring 
point:
• S (Single point)

Measurement of the current value
• R (RMS = root mean square)

Measurement of the quadratic mean (RMS value)
• P (peak)

Measurement of the maximum value
Subst Magn Definition of a substitute value, which is transferred in place of the origi-

nal measured value.
If no value is entered the original measured value is transferred.

Subst Angle Definition of a substitute value, which is transferred in place of the origi-
nal measured value.
An entry is allowed only in the case of phasors. If no value is entered the 
original measured value in transferred.
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 NOTE

The table of the measuring channels must be sorted according to column Meas. Mode, in order to warrant a 
correct transfer in accordance with the protocol IEEE C37.118.

Selected lines can be moved upward or downward via the context menu.

Further details see protocol IEEE C37.118.

 

4.8.3 ICCP
.

The Inter-Control Center Communications Protocol, also designated IEC 60870-6/TASE.2, is a communication 
protocol for the exchange of data between network control centers. SIGUARD PDP is able to send data to one 
or several control centers with this communication protocol.

 NOTE

SIGUARD PDP cannot receive any data via ICCP.

 

 NOTE

You need a corresponding SIGUARD PDP license for the ICCP to function. The existence of this license is not 
queried in the SIGUARD PDP Engineer.

 

To configure communication protocols, the folder ICCP is selected and a name for the folder ICCP is assigned:
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Figure 4-32 Assignment of Name to the ICCP Folder

Next, the ICCP folder is opened and a protocol is selected.

Functions

The following functions can be performed when the folder ICCP is selected.

Table 4-32 Functions for ICCP

Element Explanation
Click the button New, in order to create a new protocol with the appropri-
ate subdirectories Measurements and Groupindication.
Click the button Duplicate, in order to create a duplicate with a new 
name for the selected protocol.
Click the button Del in order to delete a selected protocol with the asso-
ciated subdirectories.
SIGUARD PDP Phasor Data Processing, Manual
E50417-H1076-C419-A3, Release 11.2011

137

http://siemens-russia.com/


SIGUARD PDP Engineer
4.8 Communication
ICCP Communication settings

If you have selected an ICCP_Main in the window section Available communication interfaces, the following 
middle window section Communication - ICCP is displayed.

Figure 4-33 ICCP Communication Settings

The setting options for the properties/ICCP communication settings are explained in the following table.

Table 4-33 ICCP Communication Settings

Element Explanation
Local Settings
Name Definition of the name of the ICCP interface.
initiator If the check box is selected, then SIGUARD PDP is the initiator of the 

communication.
Local Domain Name Definition of the local domain name
Local AR name Local application reference name 
Remote Settings
Remote Domain Name Domain name of the partner
1st Remote AR name 1st application reference name of the partner

Up to 4 names (corresponding to 4 computers at the partner) are support-
ed.

2nd Remote AR name 2nd Application reference name of the partner
Up to 4 names (corresponding to 4 computers at the partner) are support-
ed.

3rd Remote AR name 3rd Application reference name of the partner
Up to 4 names (corresponding to 4 computers at the partner) are support-
ed.
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4th Remote AR name 4th Application reference name of the partner
Up to 4 names (corresponding to 4 computers at the partner) are support-
ed.

Version
ICCP Version The ICCP version with which this protocol is supposed to be compatible 

is set in this list box.
The versions 1996-08 and 2000-08 are supported.

Bilateral table ID Identification of the bilateral table
In this table, the information exchanged via the protocol is listed and as-
signed an agreed name. Various versions of this table should show dif-
ferent identifications.

Heartbeat
Link heartbeat If the check box is selected, then test telegrams are exchanged for veri-

fication of the functionality of the communication link.
Link heartbeat interval (msec) Interval between 2 verification telegrams
Data Package Parameters
Max MM SPDU Size Maximum size of the PDU for MMS reports, in bytes.

The current PDU size is determined between the communicating peers 
and can be below the maximum size. The PDU size determined is used 
in order to divide large data volumes into smaller units for delivery.

Client Response Timeout (s) When the ICCP client receives a select or operate request from a moni-
toring unit and sends the request to the ICCP server, this timer starts. The 
ICCP server must confirm the request before this time runs out.

Association Request Timeout (s) After this time elapses, the time for a connection attempt has been ex-
ceeded. This means that, if your system initializes the connection, then it 
sends it a message to the peer in order to establish a connection. If no 
answer arrives within the time set under Association Request Time-
out, then your system interprets it as a failed connection establishment. 
The system then waits for the time set under Association Request 
Retry, before it tries again to establish a connection. This is only signifi-
cant if the parameter Association Initiator is set on Yes.

Association Request Retry (s) This is the number in seconds that must elapse between connection at-
tempts. This means that, after a failed connection attempt, the system 
may not start a new connection attempt until this time has elapsed. See 
also Association Request Time-out. This is significant only if the pa-
rameter Association Initiator is set on Yes.

Server Settings
Server Response Timeout (s) This time-out value is used only by the ICCP server. The ICCP client 

sends a select or operate request. The ICCP server receives this request 
and sends it to a supervisory control. The counter does not start until af-
terward.
The supervisory control must confirm the request within this time. For 
problem-free operation with ICCP, Siemens recommends setting a value 
below the Client Response Timeout for this value.

Element Explanation
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ICCP Measurements

If you have selected the subdirectory Measurements of an ICCP protocol, the following middle window section 
Communication - ICCP is displayed.

Figure 4-34 ICCP Measurements

For the definition of the measuring points, defaults must be selected so that only these specific parameters are 
accepted.

The window section Default settings for drag and drop operation contains several check boxes with which 
it is possible to select which information is transferred over ICCP via drag and drop.

Server Reply Timeout (s) If a message has been sent to a server (peer), time-out does not occur 
until this number of seconds has passed. When this time runs out and the 
peer does not answer, then the communication with the remote peer is 
interrupted.

Shortest Periodic Interval (s) For an ICCP-Peer, periodic data transmissions in intervals that were pre-
viously determined remotely can be necessary. This parameter is the 
shortest time interval, in seconds, that your system accepts. This param-
eter prevents an incorrectly configured Remote-ICCP-Peers from over-
whelming your system with data requests.
Example: You have set this value, for example, to 30 s. A client creates 
a transmission group with a periodicity of 10 s. ICCPNT recognizes that 
this value is too small, creates a protocol entry, and automatically adapts 
the periodicity of the transmission group to 30 s.

Element Explanation
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Next, the measuring points are pulled into the middle window section via drag and drop. For every measuring 
point, a row is created in accordance with the defaults (parameters).

The setting options for the parameters of the measuring points are explained in the following table.

Table 4-34 ICCP Parameters for the Measuring Points

There are 2 options for modifying the events:

• Globally changing the parameters according to the selection in the lower part of the middle window sec-
tion.

• Manually changing the parameters that cannot be changed globally.

For this, a row of the measuring point is selected. The default parameters are now also selected in the lower 
part of the window section. Remove the selection, for example, for Max1. The corresponding parameters for 
this row are deleted.

Element Explanation
Server objects Here, measured values from the Available measurements are saved 

via drag and drop. Note that, depending on the selection of the Default 
settings for drag and drop operations, several server objects can be 
created with one drag and drop operation.

invert If the check box is selected, then digital values of 1 are transmitted as 0 
and vice versa.

Slope Values from SIGUARD PDP can be adapted in their size with a slope. For 
example, the voltages in SIGUARD PDP are processed generally in V. If 
the destination system is supposed to receive the values in kV, then enter 
a slope of 0.001 here.

Offset Using the offset, values from SIGUARD PDP can be adapted to the des-
tination system by adding the offset to the output value.

Global If the check box is selected, the destination system can distribute this 
data via ICCP.
If the check box is not selected, then transmission through the destina-
tion system is not allowed.
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Figure 4-35 ICCP Measurements with a Hidden Parameter
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ICCP Group Indication

With this editor, you can communicate monitoring notifications created through SIGUARD PDP, for example, a 
communication error to a PMU or an error in the archive, to a SCADA system and display them there. You can 
select individual messages or entire groups out of a large number of SIGUARD PDP messages and assign 
them to one or several ICCP events.

If you have selected the subdirectory Group indication of an ICCP protocol, the following middle window 
section Communication - ICCP - ICCP measurements is displayed.

Figure 4-36 ICCP Group Indication

Various events are selected that are pulled into the middle window section via drag and drop.
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Figure 4-37 ICCP Group Indication with Inserted Events

Individual events can be assigned to an existing group (insertion in a gray field under the object name).

Cumulative events are created after insertion as a group with a new object name (insertion in a white field in 
the row Object name).

The setting options for the parameters of the events are explained in the following table.

Table 4-35 ICCP Parameter for Group Indication

Element Explanation
Object name Name of the ICCP event object
Incidence key The SIGUARD PDP events selected for transmission to the ICCP desti-

nation system are identified by Incidence Key and Element Type. Several 
SIGUARD PDP events can be linked to an ICCP event.

Element type

ID ID is the name of the object that is the reason for the event. You see the 
same name on the corresponding pages of Engineer on which you pa-
rameterize the object. If there is no object that is associated with this 
event, you have no ID.

invert This check box controls whether a 0 or a 1 is transmitted with SIGUARD 
PDP events.
If the check box is selected, then a 1 is transmitted by SIGUARD when 
an event occurs.

Global If the check box is selected, the destination system can distribute this 
data via ICCP.
If the check box is not selected, then transmission through the destina-
tion system is not allowed.
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4.8.4 OPC
.

SIGUARD PDP includes an OPC server that allows access to the data from SIGUARD with the Data Access 
Profile version 3.

 NOTE

You need a corresponding SIGUARD PDP license for the OPC to function. The existence of this license is not 
queried in the SIGUARD PDP Engineer.

 

To configure the measuring points for the OPC server, the folder OPC is selected.

Figure 4-38

To configure the measuring points for the OPC server, the folder OPC is selected and a new OPC server is 
created.

You can find further information in the Administrator Manual in chapter OCP.
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Functions

The following functions can be performed when the folder OPC is selected.

Table 4-36 Functions for PDC Servers and Logical PMUs

OPC Parameters

If you have created a new OPC server, the following middle window section Communication - OPC is dis-
played.

Figure 4-39 Define OPC Server

Element Explanation
Click the button New, in order to define a new OPC server and assign 
measuring points to the OPC server
Click the button Del, in order to delete an existing OPC server.
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The setting options for the OPC server are explained in the following table.

Table 4-37 OPC communication settings

Figure 4-40 OPC Server with Assigned Measuring Points

You can find further information on saving, activating, and validating the project in chapter 4.9 Shared Func-
tions.

Element Explanation
Server name Definition of the name of the OPC server.
Port Port to which the OPC server is connected.
Measurement Using drag and drop, the measured values from the list Available mea-

surements that are intended to be transmitted through the SIGUARD 
PDP OPC server can be inserted here.

invert This setting is active only in the case of digital measured values.
If the check box is selected, then the display of the binary signal is invert-
ed, that is, a 1 is transmitted as 0 and vice versa.
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4.9 Shared Functions
.

For all editors in SIGUARD PDP Engineer, the following shared functions are available.

Entries

An entry field is highlighted in red if an entry is required. Entries are transferred into the configuration by:

• Operating the <Enter> key

• Operating the <Tab> key

• Moving the cursor from out of the entry field

Entries of decimal numbers are only valid if they are entered with a period (for example, 0.01).

Saving a Project

The data of a project should be saved after every change or reconfiguration (local copy of the configuration). A 
configuration that is not yet valid can be saved but not activated.

Validation

Current errors can be displayed in tooltips during entry. A complete validation takes place via the menu Project 

> Validate or via the corresponding icon . If error messages are displayed, re-edit the configuration. If the 
validation is free of errors, the project can be activated for the runtime process.

• Current error messages

For every element that is marked with a warning symbol,  a quick info (tooltip) can be shown. Point to 
the element with the cursor. The quick info contains the element type and a description of the error that 
has appeared.
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Figure 4-41 Current Errors in Tooltip

• Error messages after Validation

In the lower window section Project validation - Errors error messages are shown based on the valida-
tion, for example:

- Info (tab name): Description

- Error (tab name): Error description
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Figure 4-42 Example of an Error Message

This window section can be hidden so that only the header is visible. The number of error messages is dis-

played in the header. If error messages occur, a red warning symbol also appears  in the header (for exam-
ple, in the tree structure of Calculated measurements), in order to clarify which configuration triggered the 
error message.

After processing the error messages and a revalidation, no more messages should be displayed. The project 
is valid.

Activation of a Project

After successful validation, an opened and saved project can be made available to the runtime process. This 

takes place via the menu Project > Activate or via the corresponding icon . At the same time, the config-
uration is written to a defined position in SIGUARD PDP UI or an existing configuration with the local copy from 
SIGUARD PDP Engineer is overwritten. SIGUARD PDP UI must then be restarted.

■
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Working with SIGUARD PDP Engineer
5.1 Overview
5.1 Overview
.

With the help of examples, the use of SIGUARD PDP Engineer shall be demonstrated to you.

The suggested procedure is to illustrate the individual steps for parameter assignment with 
SIGUARD PDP Engineer.
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Working with SIGUARD PDP Engineer
5.2 Example: Project, PMU
5.2 Example: Project, PMU
.

Proceed as follows:

• Create a new project.

• Create a new, physical PMU.

• Create a new, logical PMU.

• Define the measuring points for this logical PMU.

• Save the project.

• Perform the validation.

• Activate the project for the runtime process when the configuration is complete.

Creating a New Project

✧ Click the button  in order to create a new project.

The dialog for entering the project name appears.

Figure 5-1 Dialog Create New Project

✧ Enter the name for the new project.

✧ Confirm the entry with the button Create.
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Working with SIGUARD PDP Engineer
5.2 Example: Project, PMU
Opening an Existing Project

✧ Click the button  in order to open an existing project.

The dialog for opening the project appears.

Figure 5-2 Dialog Open

✧ Select the directory in which the file type SIGUARD Engineering File is found.

✧ Select the SIGUARD PDP Engineer file (SEF format).

✧ Confirm the entry with the button Open.

The project data are loaded.
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Working with SIGUARD PDP Engineer
5.2 Example: Project, PMU
Creating a New, Physical PMU

✧ Go to the PMU tab.

✧ Select the directory All PMUs.

✧ Click the button  in the window section Available PMUs in order to create a new, physical PMU.

The window for entering the parameters for a physical PMU is displayed.

Figure 5-3 Parameters of a Physical PMU 

Fill out the required entry fields marked in red.

✧ Enter the name in the field PMU device name and confirm with the <Enter> key.

The name will be inherited in the overview Available PMUs.

✧ Enter the PMU device ID (inherit from the PMU).

✧ Enter the IP address (inherit from the PMU).

✧ Enter the Port (inherit from the PMU).
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Working with SIGUARD PDP Engineer
5.2 Example: Project, PMU
Creating a New, Logical PMU

Every physical PMU must always have a logical PMU created under it. The new, physical PMU is still marked.

✧ Click the button  in the window section Available PMUs in order to create a new logical PMU.

The window for entering the parameters for a logical PMU is displayed.

Figure 5-4 Parameters of a Logical PMU

Fill out the required entry fields marked in red.

✧ Enter the name in the field Logical PMU name and confirm with the <Enter> key.

The name will be inherited in the overview Available PMUs.

✧ Enter the Logical PMU ID (inherit from the PMU).
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Working with SIGUARD PDP Engineer
5.2 Example: Project, PMU
Defining Measuring Points

✧ Select the field Name in the table.

The name of the PMU device and the Logical PMU ID are inherited from the text boxes above.

✧ Enter a name for the measuring point.

A second row is inserted into the table. The line can be used for the definition of a further measuring point.

Figure 5-5 Name of the Measuring Point

✧ Enter the Index (inherit from the PMU).

✧ Enter the type of measuring point via the list box Type (inherit from the PMU).

The selected parameter is inherited.
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Working with SIGUARD PDP Engineer
5.2 Example: Project, PMU
Figure 5-6 List Box Type

✧ Enter the unit of the measuring point via the list box Unit (inherit from the PMU).

The selected parameter in inherited.
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Working with SIGUARD PDP Engineer
5.2 Example: Project, PMU
Figure 5-7 List Box Unit

✧ Select the corresponding check box Archive, if the measured values of the measuring point should be 
saved in the archive.

✧ Enter the rated value in the column Nominal.

✧ Enter the lower limiting values (Min1 to Min3) and select the corresponding check box.

✧ Enter the upper limiting values (Max1 to Max3) and select the corresponding check box.

✧ Enter the Factor PSS (Standard = 1).

✧ Select the check boxes for the values that should be included in the measurement.

Saving a Project

✧ Click the button  in order to save a project.

Perform Validation

✧ Click the button  in order to check the project for validation.

If errors are still present, these are shown as Error (Project): ....

If the validation is faulty, it is shown as information Info (Project): ....
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Working with SIGUARD PDP Engineer
5.2 Example: Project, PMU
Figure 5-8 Info (Project):

Activating Project

✧ Click the button  in order to save a project for the runtime process.

 NOTE

Activate the project only after the configuration is complete.
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Working with SIGUARD PDP Engineer
5.3 Example: Calculated Values
5.3 Example: Calculated Values
.

Proceed as follows:

• Create a new project (see 5.2 Example: Project, PMU).

• Create a new calculated value.

• Set the parameters for this calculated value.

• Save the project.

• Perform the validation.

• Activate the project for the runtime process when the configuration is complete.

Create New, Calculated Values

✧ Select the Calculation tab.

✧ Select the directory All calculated objects.

✧ Click the button  in order to create a new calculated value.

The window for entering the parameters is displayed.

Figure 5-9 Parameters for a Calculated Value

Fill out the required entry fields marked in red.

✧ Enter the name of the new, calculated value and confirm with the <Enter> key.

The name will be changed in the overview accordingly.
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Working with SIGUARD PDP Engineer
5.3 Example: Calculated Values
✧ Enter the Factor (Standard = 1).

✧ Enter a formula via the list box Formula (for example, Add two analogs).

The selected formula is inherited.

Figure 5-10 Selection of the Formula

✧ Select the check box Save results to archive, if the calculated measurement should be saved in the ar-
chive.

Saving a Project

✧ Click the button  in order to save a project.

Perform Validation

✧ Click the button  in order to check the project for validation.

If errors are still present, these are shown as Error (Calculation): ....
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Working with SIGUARD PDP Engineer
5.3 Example: Calculated Values
Figure 5-11 Missing Input Measurand

The missing input measurand is shown as an error (fields are highlighted in red).

✧ Drag the input measurands from Available measurements (Type: Analog) into the fields Input measure-
ments.

The error messages are no longer shown.

Activating Project

✧ Click the button  in order to save a project for the runtime process.

 NOTE

Activate the project only after the configuration is complete.

 

■
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Working with SIGUARD PDP Engineer
5.3 Example: Calculated Values
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Glossary

Google Earth

Google Earth is software from the company Google Inc. and displays a virtual globe. It can overlay satellite and 
aerial images of different resolutions with geodata and show them on a digital elevation model of the earth.

In SIGUARD PDP, the map that is displayed in the window section SIGUARD PDP UI - Map is created based 
on maps from Google Earth.

SIGUARD PDP (Phasor Data Processing)

Software for monitoring the status of power distribution in extensive power-supply systems.

SIMEAS R-PMU

SIMEAS R-PMU is a device that, in addition to writers, contains an integrated Phasor Measurement Unit 
(PMU). The PMU measures phasors and makes them available in a database. This is a highly accurate mea-
surement of the vector quantities of voltage and current in terms of amplitude, phase angle, and time synchro-
nization.
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